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How to Use This Manual

The SilverLode™ Servo Family User Manual is a technical reference designed to aid users in the
operation and programming of the SilverLode™ product family which includes the SilverNugget™,
SilverSterling™ and SilverDust™. QuickControl®, QuickSilver’s software interface, is used for
programming, initializing and testing all SilverLode products. The companion publication, SilverLode™
Servo Family Command Reference, provides details on all commands.

Notations

SDnn
This notation means the feature or command being described was introduced in SilverDust rev nn.

SSnn

This notation means the feature or command being described was introduced in SilverSterling rev nn.

SNnn
This notation means the feature or command being described was introduced in SilverNugget rev nn.

Warnings

The QuickSilver Controls, Inc (QCl) SilverLode servos are high performance motion system. As with any
motion system, it is capable of producing sufficient mechanical output to cause bodily injury and/or
equipment damage if it is improperly operated or if it malfunctions. The user shall not attach a QCl
product to any mechanism until its operation is fully understood. Furthermore, the user shall provide
sufficient safety means and measures to protect any operator from misuse or malfunction of the motion
system. The user assumes all liability for its use.

A Do Not Hot Plug The SilverLode Product! Connecting or disconnecting hot wires or plugs is
defined as Hot Plugging. A hot wire is a wire with voltage in it. When this occurs, the residual current in
the power circuitry (motor windings, power supply, voltage clamp, 5 Volt supply, communication
power...) attempts to find the path of least resistance to ground (before the proper ground connection is
established). In most cases this path is through the communication lines (but is not limited to
communication failure). The available protection devices are not rated for high transient power spikes,
or repeated spikes. Repeated spikes can weaken communication slowly to the point of failure. In some
cases, total communication failure can occur in the first and only instance of Hot Plugging. In
applications, this can be overcome by connecting chassis ground to the power supply ground. With this
direct ground implemented, the path of least resistance for residual power is through the added chassis
ground. In applications where chassis ground is isolated from power ground, take EXTREME care not to
Hot Plug. Contact QCl if necessary.

User must remove motor from load before initializing the servo or aligning motor index pulse to
prevent potential injury or damage.



A If Index Phase Alignment option is used, the user must re-run the Initialization Wizard after
replacing either motor, encoder, and/or driver; motor must be removed from load prior to powering up
system after changing any of these elements to prevent potential injury or damage. Start the wizard
with the power turned off, and turn on power when instructed.

A Units shall not be used in life critical applications without the signed authorization of the
President of QuickSilver Controls.

>

User is responsible to provide safety interlocks for any application that may cause injury or
damage in either normal or abnormal operation of the unit.

A The SilverNugget N3 must be wired with a voltage clamp (i.e. QCI-CLCF-04) between the N3 and
the Driver power supply; the SilverNugget N2 and SilverDust D2 MG may require a voltage clamp,
according to the application. The voltage clamp must be placed close enough to the SilverLode
controller/driver to guarantee that the voltage difference between the module and the clamp at
maximum current never exceeds 1.5 Volts. (This includes the drop across both the power and ground
conductors.) See Technical Document QCI-TD017 High Current Clamp Module - QCI-CLCF-04, QCI-CLOF-
04 for information concerning the voltage clamps.

A Do not mechanically back drive the motor of a SilverLode servo without a voltage clamp present.
The voltage generated may damage the electronics.

A User shall limit current to the SilverNugget N3 and SilverSterling S3 units to no more than 35A,
or shall fuse power to the SilverNugget N3 using a slow acting fuse rated at not more than 35A. Other
units (D2, N2, S2) should have their input current limited to no more than 8 amps.

A These products are intended to be used with the appropriate power supplies, motors, electrical
protection components and other equipment to form a complete end product or system. They must be
installed by a professional assembler who is familiar with the requirements for safety and
electromagnetic compatibility (“EMC”). The products are to be tested in the final application at the
system level. The assembler is responsible for ensuring that the end product or system complies with all
the relevant laws in the country where it is to be used.



What's New For QuickControl 6.037?

QuickControl 6.03 has been compiled to work with XP, Vista, and Windows 7 (Trademarks of Microsoft).
New firmware commands and registers may be accessed with this latest version.

Application Related Information

Detailed application programming examples are available with the QuickControl software. They are
found in a subfolder of the main QuickControl install folder named “QCl Examples”. QuickControl can be
downloaded from the QCI website www.QuickSilverControls.com. The website also contains QClI
Application Notes that offer the user details of operation in specific applications.

Trademarks

® QuickControl® and QCI® are Registered Trademarks of QuickSilver Controls, Inc.

SilverLode™, SilverNugget™, SilverDust™, SilverSterling™, PVIA™, QuickSilver Controls™, and AntiHunt™
are trademarks of QuickSilver Controls, Inc.

Copyright
The SilverLode servo family's embedded software, electronic circuit board designs, embedded CPLD
logic, and this User Manual are Copyright © 1996-2013 by QuickSilver Controls, Inc.



Chapter 1: Quickstart Motion Guide

WARN'NG Read Warnings section at the beginning of this manual before connecting any

hardware. Failure to do so may result in injury or damage to the product. DO NOT connect the motor to
any mechanism until you understand its operation. DO NOT connect to any mechanism which may
present a hazard to the user in either normal or abnormal operation. Keep clear of any pinch points in
mechanisms.

Connecting the Hardware

Connect the motor to the controller using the motor interface cable (these typically have black
overmolded connectors and a ferrite bead). Connect the serial connections to the controller. DO NOT
connect any serial adapters to their USB ports at this time. Make connections to the power supply, but
do not yet connect the power supply input power.

USB Serial Ports and drivers

Make sure to use latest drivers. These are available on our web page for downloading. The default
windows drivers, in some instances, are several years old and are known to cause problems. Install the
drivers first and then only connect the USB port when prompted by the installation software.
Connecting the USB ports before installing the drivers will cause the default drivers to be installed.

Most USB serial ports need to have the power down option turned OFF in the device manager. The USB
hubs serving the serial port also need to have the power down option turned OFF in the device
manager. Leaving the power down option turned on may allow the computer to turn off the serial port
while QuickControl is using the serial port, which will cause faults. *see Appendix Il for details on
disabling the auto power save.

Hardware Requirements

e Personal computer with a Pentium (at least 500Mhz) or higher processor running Windows XP,
Vista, Win 7.

e Anunshared serial port capable of communicating at 57,600 Baud or better (USB to serial
adapters ok).

e Some models include an Ethernet connection as well. Please See Ethernet Bridge section for
more details.

e QuickControl Software, which is free to download from
http://www.quicksilvercontrols.com/SP/SW/QuickControl.html This will need an internet
connection to install the .NET libraries from MicroSoft.

Install QuickControl

Install QuickControl as follows: Run the downloaded QuickControl installation program "Setup.exe". If it
asks for administrator privileges, allow them. If the Microsoft run time libraries are not already installed
on your system, you will be directed to download them from Microsoft.

Note: on Win 7 and Vista, QuickControl may need to be run as an administrator for proper functioning.
Configuring the program for WIN XP compatibility mode is also suggested. This may be done by selecting
QuickControl.exe , right clicking and selecting properties. From there, run as Administrator and XP
compatibility check boxes may be set.



10 Minutes To Motion

Run QuickControl 1st Time And Setup Communications

Run QuickControl: From the Start menu,
Start > Programs > QuickControl O

If your comm port has not yet been enabled (true for any first time
users), QuickControl will prompt you to enable the Comm Port and

initialize your servo.

Press OK.

QuickControl (3]

@& ThePC's COM port can besetup by selecting

"~ Setup->Comm Port

To change the Comm Port at a later time, go to Setup
menu, select Comm port, and then press Modify to

bring up the Comm Properties Window, which can be
used to select the correct COM port or to change the

Baud Rate.

QuickControl @

e 1 Welcome

For a tutorial, please go to the Help menu
Help Topics-» Getting Started

Cancel

Press OK.

Setup Communication Port

0K

Cancel
Once the desired device has been selacted,

The Communcation Port maybe modified by
puzhing the Modify Button,

check "Enable’". Modify

Communization Device Properties

COME, 8-Bit ASCI. Baud=57600

Comm Properties

Cancel
COM | E-485 Bridge (Ethemet) |

COM port COM3 | Enter COMnnn
Default=COM1 (i.e. COM200) or

select from list
Baud Rale [7e =] Press OK when you are finished in either window.
Default=57600 57.86 y
Protocal 8-Bit ASCI 2 Stop Bits, No Parity ‘
Default=8-Bit ASCI, No Parity, 2 Stop Bits

QuickControl

‘.ro.' Initialize your Device

1) Attach the Device to the PC as described in the
User Manual.
2) Power up Device (turn device on)

3) Run the Initialization Wizard from the Tools menu

Press OK for me to do this for you

Verify your hardware is setup correctly. Do not connect the
motor to a mechanical load until you are familiar with its
operation and established any necessary safety interlocks. If your
unit requires a clamp or clamp resistor, connect them now.
Power up device and press OK.

This will launch the Initialization Wizard.
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Initialization Wizard
This wizard can also be launched from the Tools menu.

Select Open and select the appropriate initialization for your application and hardware. For these
examples we are assuming a basic operation using one of our standard QCI servo motors. Different
initializations are needed for open loop, and for DC motors and Voice Coils, as well as for CAN operation.
See appendix 1 for alternative initialization scenarios.

Initialization Wizard Enter the Motor Cable Length in the feet. This can
Prezs "Download..." to initislize servo or change the : be found on the last two digits of the cable part
factory default parameters using the "Initialize Parameter = X ,
Browser", number. For example, a QCI-C-D15P-D15S-04 is a 4

cable. If motor is directly connected to controller

Initialization ‘Wizard | Tuning ‘Wizard |
Device "UID=16" gptions | | Dowricad Fis (such as a QCI-D2-MG) enter 1 for the length.
Matar ATTEI Ta Device
DEVICE DETECTED: Uit 1D = 16 Matar Cable Press "Download File To Device" to initialize the
SilverDust D2 1G, sn=4549 Length

servo using factory defaults.

|-Grade Motor: £23H3, CPR=8000, zn=3122 |4_ ft
[Factory Default Inialzation acp A message will appear when the download is
QOpen Uit Be (e reetey BT complete. Press OK to acknowledge message.
H- Communications
Save v Motor “ ” . .
Servo Turing Press “Save As” to save the file with a name
SR : E"”“”C_ ) meaningful to you, if you have changed anything in
-+ EImar Limits
i Misc the initialization file, including the ID.

Exit via the X box in the upper right hand corner.

Initialization is complete!

Please note, the Initialization Wizard must be re-run anytime the encoder is loosened, or a different
motor/encoder pair is connected (if the Index alignment option is used). If an I-Grade motor is used with
an |-Grade SilverDust or SilverSterling controller, the motor can be changed with another of the same
type without re-initialization.

Please see Appendix |: Sample Programs and Exercises for a list of possible Initialization scenarios that
you may encounter, as well as sample programs included in QuickControl and for additional exercises to
help you start programming your device from here.

Control Panel

Open Tools=>Control Panel and a control panel window will open. To verify that the motor and
controller are operational, left click and drag the purple slider bar up and down to produce forward and
reverse motion. The speed scale box, just above the slider may be changed to allow a faster motion. The
move commands may also be used to test particular motions.

11



Device| ID=1E:LID=1E
Type | A23H3 [Rev 56-11)
Sefial #| 4543

— Device Status

Target PDsllj— counts
Positionln— counts
\-"elncitylg— 5

PosErarl0 counts
| Maw Error |43 counks
Torquel3E|—
Driverl‘la_n— :folts
Temp[295

(ContralPoRet ==

— Tuning
LCuycle |
1 HCycles s
Q=farever delay
tove Type
O MRT O Cycle
WO MRV
Test Move 1 |

Pasition ISDDD counts
Ramp Time |3U maec
Total Time [1000 m3ec
Test Move 2 |

Pasition ID counts

Ramp Time|1DD m3ec

Total Tirme I‘I ii] mSec

Strip Chart |

Jog Vellcps) Eit |
430000
P— Restart |
Jog
a0oo0 ——
=) =
q2000 —— STOP
- [_stoe |
9SE2DDDDDD i
A000 M otor Diriver
84000 —— (¢ Enabled
'SDDDD " Disabled
— Inputs/Outputs
Set: Shift L-Click
Clear: Crtl L-Click
Tri-State: L-Click

am=righ [ [a. [8 Ji |81 & Jil
e T

" I OO
Analog 1%2@3@4%

. Create and Run First Program

A. Move 8000 Counts At Power Up

We will create a new program that causes the servo to move 8000 encoder counts when it powers up. You should
be polling and have device showing in the left panel to enable you to see the position of the motor. If your status is

not green, press Scan Network on the Device Status Monitor

Create a new program by selecting New Program File from the File menu.

File -> New Program File

File Edit View Programs Tools Setup Window Help

D| || & | | 8@ |2 @

| For Help, press F1

Program Info Toolbar Line# Label | Command Device Status Monitor
. (Ot B R —
— Program Line 1:REM ID=16 IU— counts
| Add [Critl-&) Edit [Crt-E]
Insert (k]| Delet (CrtkD) o
= s, B 5 6
e T o o
Download | Download/Restart
Sealing Download/Fun Stap Paling | Palling
Test Line I Run w/o annlnadl |D:Desc/Cont Pos/State
16:UID=16 0 counts
Deb
= ul D216 AZ3H3 | Prag Sio
Program List
IProglam Mame [0] -
0 of 1023 wards used I
~ Device Ta Program
FRestart |
|
093219674 Uit ID=016: SilverDust Found
083319676 Unit ID=016:  Driver=D2
033319677 Urit ID=016:  sn=4541, rew B6-11 1223 2010
0533319678 UnitID=016 |G [
0%:3319.680: UnitID=016  Matar=0C1 |-Grade 17K
053219683 Scan for Unit [Ds 1 thiough 20 complete. Select Setup->Options to change scan range.
NUM A

Your screen should look like this.
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We will now add a Move Relative Time Based (MRT) command to the user program.

On the Program Info Toolbar (left side, approximately
1 inch down from the top), press Add.

Select Program Line

=)

Lizt Mozt Uged Commands For

Add aline after line # 1 oK

& Al " SilverDus! =

" SilverNuggs © SilverSterling Cancel

MIT MOVE [FLow |10 | REG | MISC | can ALl | REM |

Category | TLA Cormmand i
MOWE EGI Electronic Gearing Mode, Interpolate
. . . MOVE EGM  Electronic Gearing Mode L
The Select Program Line dialog box will appear. Select MOVE |HSM  Hard Stop Move E
the MOVE tab. MOWE 1519] Interpolated Move Queue Clear
MOWE 145 Interpolated Mowve Start
MOVE MAT Move Abzolute, Time Based
MOVE MaY  Move Absolute, VWelocity B ased
MOVE ove Relative, Time Based
MOVE Move Relative, Yelocity Based
Double click on MRT and the Edit Move dialog box MOVE |PCG  Pre-Caloulated Go
X MOVE  |PCM Pre-Caloulate Move
will appear. MOVE |PIM  Pasition Input Mode
MMVE PRI Prafile b e Corbien s T
Edit MRT:Move Relative, Time Based ==
Edit the move data as shown. This will produce a relative move
Dict Cancel of 8000 counts in 1 second with a 100 millisecond ramp at the
Istance
o courts Description start and end of the motion. Press Test to preview the motion.
— The motor should spin.
Stop Condition
Rarmp Time .
A0 mSec I Test Press the OK button to add this command to your program.
Stop
Tatal Time
hDDD mSec m Ii

On the Program Info Toolbar, press Download/Restart. QuickControl will download your program to the servo's

non-volatile memory. It will then restart the controller and go 8000 counts in 1 sec. You can press Restart to cause

the program to execute again.

The program you just wrote will execute every time the servo powers up.

Select Save As from the File menu to name and save your program.

Congratulations! You are a programmer.

B. Stop a Move Using a Digital Input

To make the move stop depending on the state of a digital input, the
move needs to be edited.

1) Double click the MRT program line.
2) Press the Stop Condition button.

3) Select the Standard tab.
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hooo mSec  ~ Ii

D

. Cancel
Diztance
2000 counts I— Description
Ramp Time
100 msec ' f—— Lk
Stap
Tatal Time




4) Select 1/0 #1 and LOW/FALSE. The dialog box should look this:

Edit Stop Conditions =]l This selection will cause your move to stop when
Stendard | Advanced | Input #1 is LOW.

Stop move when input is in the
indicated state.

5) Press OK to save and exit.

Condition State
Fetiis = TR 6) Press OK to exit the Edit Move dialog box.
alling

Rising

| 7) Press the “Download/Restart” button on the
Program Info Toolbar and verify the move stops
when Input #1 goes LOW

8) Either press Restart, or power down and power
0K el | e || UpYyour servo, and verify the program runs again.

C. Starting a Move Using a Digital Input
There are many ways to start a move using a digital input. Most of them involve adding a Program Flow command

to the program. We will now add a command that will cause the servo to wait until Input #5 is LOW before
executing our move. Note: if you do not have a physical switch, you can also simulate I/0 using the Control Panel.

Open Control Panel, on the lower right side will be indicators for each of the 10 bits on the controller. Clicking on
the 10 will set it to tristate (or off for the 24v 10). Holding the Shift button and clicking on the 10 will set the 10
(turn on the 24v 10), and holding the Ctrl key and clicking on the 10 will clear 10 low (turn off the 24 10). The
instructions are next to the indicators to help remind you.

1) With the MRT command selected, press the Insert button (top, left) to insert a line above the selected line, in
this case, above line 2. (note: pressing Add will add a line below the selected line). The Select Program Line dialog
box will appear.

2) Select the FLOW tab.

3) Double-Click on the WBS - Wait on Bit State - command. This command will cause the servo to wait at the
program line until the condition is met.

4) Enter the data as shown.
=

Select Program Line

List Most Used Commands For
. ak. 5) Press OK to add the command to the
a0 ™ SiverDus!

(" SilverMugge © SilverStedin Cancel program.

NIT | MOVE FLOW |10 | REG | MISC | CaN | AL | REM |

Inzert a line before line # 2

| | 6)Setl/O 5 high, and then Press
“Download/Restart” to run your program.

-

Category | TLA Command
FLOW MXT  Mest

FLOW | PCB  Program Call On Register Bitmask Note, the servo does not move until Input #5
FLOw |PCl  Program Cal On Input goes LOW and will stop early if Input #1 goes
FLOMW PCL Program Call

FLOMW FRI Program Returm On Inpuk LOW.

FLOMW PRT Program Feturm
FLOW RSP FRestart, Program Mode

FLOM Thread 1 Force LRF
FLOW Thread 2 Start L Edit WBS:Wait On Bit State (5]
FLOMW ‘whait O Bit Edge 1 _ N .
FLOW it O Bit State Select which candition to wait on
FLOW  WDL  Wwait Delay
- Condition Cemee]
~|  Desciiption
State

" Low / FALSE
&+ High / TRUE
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D. Do Forever
To make the program repeat after it finishes the move, Edit JIMP:Jump

we will add a JMP command (FLOW) to the end.

1) Select the MRT program line.

2) Press the Add button.

3) Select the Flow tab.

4) Select the JMP command.

oK

Cancel
Select from existing labels or enter a new one.

START ﬂ Description

kg

Select conditions far Jump

LConditions |

5) In the label field, enter the word “START” as shown on right.

6) Press OK to exit the Edit Jump Command dialog box.

7) You have just added a command to jump to the program line with the label “START”. Add this label to line
number 2 by clicking on the line 2 label cell and type “START”. The JMP command will now loop to line 2 after it

finishes the move.

Linet
Oper
1:REM

2WwBS

ZMRT

4:JMF

Label

START!

Cormmand

Wait Or Bit State

nhl "140 #5" iz HIGH/TRUE
tiowe BOO0 counts (2

ramp time=100 mSec

tokal time=1000 mSec

Stop when "1/0 #1" i

L FALSE

Jump to "START"

8) With both Input #1 and Input #5 HIGH, run the program.
Verify the motor does not spin until Input #5 goes LOW. Verify
the motor executes its move until Input #1 goes LOW.

9) Save the program under a hame of your choice. You can look
at a fully documented version of the program by opening: QCI

Examples\ Using Inputs for Move Selection\Tutorial-Using an Input to Start and Stop a Move.qcp
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Chapter 2: Expanding Your Program

Basic Motion Commands

There are four basic motion commands that are used to create simple motion profiles. These commands
follow the same motion rules, but require different motion parameters. The result is a similar type of
motion. The differences between the commands allow motion to be defined by relative or absolute
distance, using velocity or time as the base. The commands pre-calculate the motion profile. The motion
profile is subject to the maximum acceleration and velocity of the servo motor. A motion profile that the
servo cannot numerically accomplish will cause a command error and the motion will not be executed.
On the other hand, it is possible to program a motion profile that is numerically consistent, but requires
more torque than available in the given servo.

Relative Motion

The Move Relative, Velocity Based (MRV) and Move Relative, Time Based (MRT) commands are both
relative moves. Relative motion is distance based, meaning that the first parameter is the overall
distance to move. The starting position when the motion begins is irrelevant and the shaft will simply
rotate the specified number of counts.

Absolute Motion

The Move Absolute, Velocity Based (MAV) and Move Absolute, Time Based (MAT) commands are
absolute moves. As long as the device is powered, it keeps track of its current location based on the zero
point. The absolute position move is also based on the zero point. Please note that the zero point can be
reset using the Zero Target and Position (ZTP) command, or moved/offset using the CLC “Sub Target
Position” command. Absolute motion is position based, where the first parameter specified is the
position to move to. The actual distance moved is the difference between the current position and the
position specified in the command.

Velocity Based Motion

The MRV and MAV commands are velocity based. The second and third parameters are velocity and
acceleration. The servo will use the specified acceleration to achieve the velocity, and the same
acceleration to bring the servo to a halt. If the acceleration is not sufficient to reach the specified
velocity before deceleration must begin, the profile will be triangular rather than trapezoidal.

Note, acceleration and velocity must produce a ramp that is no more than a 7.86 seconds in duration
for the move to be accepted. Slower ramps can be produced using the PMV command.

Velocity Control

If an application requires only velocity control and no position designation, the Velocity Mode (VMP or
VMI) commands should be used. VMP is the program type command, and VMI is the immediate type.
The both Velocity Mode commands provide a “never-ending” motion. If no outside conditions interfere,
the servo motor will continue to move at the specified velocity “forever”. (Note: if the final velocity is
zero, the command will exit once zero velocity has been reached.) This command requires two
parameters, velocity, and acceleration. A SilverLode servo will achieve the specified velocity using the
given acceleration, and remain at that velocity until commanded otherwise. In a multitasking
environment, this command can override any other motion currently in progress. This provides an easy

16



transition using a controlled deceleration to slow down or stop the servo. See Chapter 3 for more
information on multitasking.

Time Based Motion

The MRT and MAT commands use time based parameters to create a motion profile. The second and
third parameters are ramp time and total time. The total time specifies how quickly the move is to be
completed. The ramp time sets the time to accelerate to velocity and the time to decelerate until it is
stopped. The total time must be greater than twice the ramp time or errors will result and the move will
not be executed.

Note: maximum ramp time is 7.86 seconds.

S-Curve Factor

SCF determines the fraction of the acceleration/deceleration period that will be used to ramp up to and
down from the needed acceleration (constant Jerk). A value of 0 defines a basic trapezoidal move, while
a value of 32767 causes the entire acceleration /deceleration period to be used. A value of 3277 uses 10
percent of the acceleration/deceleration time to transition to/from the desired acceleration, lowering
the required Jerk accordingly. A 10 percent value thus increases the maximum acceleration needed by a
timed move by 10 percent, and the acceleration/deceleration time needed for a constant
velocity/acceleration move by 10 percent.

A full s-curve will minimize the rate of change of acceleration (or jerk) for a trapezoidal motion. In a full
s-curve time based move, the actual acceleration used is double that of a pure trapezoidal (zero s-curve)
motion. In a velocity based move, the time to complete the move increases proportionally to the
amount of s-curve specified. In order to have the full s-curve move complete in the same time as the
trapezoidal move, the acceleration parameter must be doubled. The following chart shows a velocity
based move with zero s-curve (trapezoidal), full s-curve, and full s-curve with the specified acceleration
doubled.

Velocity Based Motion and S-Curve
1200

Full S-Curve

1000 7
/ m LZ x Acceleration
800
600 / / \ \/ / Full S-Curve
/ Trapezoidal Motion \ /
Same Acceleration
- \ \
0 0.1 0.2 0.3 0.4

Time

Velocity

™~

0.5
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Significant reduction in jerk in the system may be attained by a 20% or 50% s-curve (for example), where
the acceleration ramps up over a portion of the curve, then is held constant for a portion, and then is
ramped down again, with the same process occurring for the deceleration portion of the curve. A 20% s-
curve factor value only adds 20% to the acceleration in a time based move or 20% to the time in a
velocity based move, but can significantly reduce the jerk at the start and end of the move. The max
value of the SCF command is 32767; a 20% value would thus be set to 653 = 0.2*32767.

b Basic Motion Commands & Jump Commands
Qg}j The purpose of this exercise to get familiar with the basic MRV, JMP, and JOlI commands. The servo will
execute two moves depending on the state of the I/O #1 and I/O #3. The program runs in a continuous
loop monitoring the two inputs.

1. Make sure QuickControl is polling the device. Press the Scan Network button in the middle of the Device
Status Monitor to start polling the device if polling is stopped.

2. Select File - Open. Navigate to the “..\QCl Examples\Using Inputs for Move Selection\” folder and select the
file “Two Inputs Two Moves with MRV.qcp”.

3. Putl/O #1 and #3 in the HIGH state. If you do not have physical switches, open the control panel and follow
the instructions for the I/O portion on the control panel. Following the “set” instructions (hold the shift key
down and left click the given 10 indicator box) will set the I/O to a high state, while the “clear” instructions
(hold down the CTRL key and left click) will set the I/O to a low state. Verify both inputs are in the high state by
looking at the Input status boxes just above the Scan Network button. A Green box indicates the I/0 line (in
this case an input) is in the HIGH state. A Red box indicates a LOW state. Take a moment to toggle the 1/O
switches up & down to see the Input status boxes change color as the inputs change state.

4. Press the “Download/Restart” button on the Program Info Toolbar. Once the program is downloaded press

the OK button. The program is now running.

Toggle I/O #1 LOW, then back to HIGH. The device will execute a simple move.

6. Toggle I/O #3 LOW, then back to HIGH. The device will execute a different move. Experiment with the 1/0 and
notice the servo's motion. When finished close the active program.

g

Question: If BOTH inputs are LOW, which move gets executed? Why?

& Basic Velocity Mode
g?j This exercise demonstrates the basic Velocity Mode, Program Mode (VMP) command. It illustrates how
simple it is to have the device operate in a set velocity mode & stop on an Input trigger.

1. Select File > Open. Navigate to “..\QCl Examples\ Moves — basic\Velocity Mode, Program Mode.qcp”

2. Pressthe “Download/Restart” button to download and begin execution of the program. Once the program is
downloaded press the OK button.

3. The servo is now running in Velocity Mode. Notice the position counter window increasing the revolution
count value as the device moves. Toggle /O #5 LOW to stop motion. Press the Restart button to run again.
When finished close the active program.

This program contains only one command. It has all the parameters needed for simple motion control.
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&?j Creating, Downloading, and Running a Program in QuickControl®

In this exercise, a new program is created in QuickControl. It includes a short Move Relative, Velocity

Based (MRV) move clockwise and a similar move counter-clockwise. I/0 #1 can be triggered LOW to stop motion at

any time.

Creating a New Program

1.

2.
3.
4

10.

11.
12.

13.

Select New Program File from the File menu to open a blank new program template.
Choose Add from the Program Info Toolbar to place a new program command in the list.
Choose the Move tab and double-click on MRV (Move Relative, Velocity Based) command.
Enter the following values for the first MRV move:

Distance: -10000 counts

Acceleration: 1000 cps/s (¥*999.62 actual)

Velocity: 2000 cps

*Acceleration parameters are rounded as QuickControl calculates the exact motion profile.

Press the Stop Condition button.
Choose the Standard tab of the Edit Stop Conditions box. Select I/0 #1 for the Condition and use HIGH/TRUE
as the State.
Press the OK button twice to get back to the main QuickControl screen.
Highlight the newly created Line 2 and choose Insert from the Program Info Toolbar. This will insert a new
program command into the program list before the first MRV command on Line 2.
Choose the Move tab and double-click on MRV (Move Relative, Velocity Based) command.
Enter the following values for the second MRV move:
Distance: 10000 counts

Acceleration: 1000 cps/s (999.62 actual)

Velocity: 2000 cps

Press the Stop Condition button.

Choose the Standard tab of the Edit Stop Conditions box. Select I/0 #1 for the Condition and use LOW/FALSE
as the State.

Press the OK button twice to get back to the main QuickControl screen.

Downloading and Running the Program.

14.
15.

16.

Before running the program, make sure 1/0O is ON or high.

Pres ““Download/Restart” on the Program Info Toolbar. This function will Download the program into the NV
memory and restart the servo which will run the program.

The program will only run once per Restart!

While the program is running, trigger /O #1 to stop the move before the motion completes. Press the Restart
button to run the program again.

Saving the New QCP File

17.

18.

Using the File menu choose “File > Save As”. This will open a standard file browser window where the
program can be named and saved to the computer.

Note: The browser window opened by “default” will be the last active folder accessed in QuickControl.
Choose a unique name for the new program and press the “Save” button.
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Using the Register Watch Tool
This exercise explores the operation and use of the Register Watch Tool.

QuickControl must be polling for the tool to

function. If Scan Network button is visible in Select Register 5|
the right status panel, then polling is not
active. To establish polling, press “Scan
Network”. The Register Watch Tool is started Cancel
by selecting Tools > Register Watch. .
By default, no registers are displayed Regster i
Y ’ T arget Position [0) - Display
Actual Pasition [1] (*+ Reqgister
To add a register to the display press the “Add Eﬁ\ﬁ ||nF?:§;\?§;I?§] (21 " Upper word
Register” button. This brings up the Select Last Trig Position (4 ™ Lower Word
Register window. Select the register to ela- IZ:-:Lr'ute (5] . SN
. ) . b b Pl

monitor/modify from the scrolling list. Some v;zcigﬂ 'Tﬂelg;rt}l, 2#;?” asition Error (B] [ Stip Chart
are combo-registers, where the upper 16 bits Feserved [3) [~ LogtaFile
and lower 16 bits contain separate pieces of Fieserved | Torque (3]
) i i Accumulator [10)
information. These registers are named (by User [11] St

‘thi ’ Uszer or Input Source Data [12) r .
def.ault) high Wf)rd | low w0|_'d. For example, User or Input Offset (13] Alphabetically
register 7 contains two velocity values and is User of Input Dead Band [14]
named “Velocity 1 | Velocity 2.” To view only User or Mawimum 5 calelLimit [15] -
one half of register, select either ‘Upper Word’

or ‘Lower Word’ from the Display section.

Select register 5 ‘Delay Count’ and ‘Register’ to view the timer register. Press OK to bring up the format
window. Select the desired data format. Long and ULong display the exact contents of the register with no
units. This is useful for inputting basic numbers, or for viewing SilverLode native units. The Hex option
translates the contents from decimal to hexadecimal. This format allows easier analysis of individual
register bits. Position, Acceleration, Velocity, and Time options all scale the register value using the
current QuickControl units. Select ‘Long’ to display register 5 in native units.

Clicking OK a final time places the register into the tool. Click on the data box of register 5 (which
currently contains a zero). Enter a numeric value of 10,000 or greater. Once the value has been typed,
press enter. At that moment, the value typed in will be transmitted to the controller, and immediately
begins decreasing. The Delay Count register is a specialized register that is automatically decremented
each servo cycle. As demonstrated here, QuickControl is also constantly reading registers and reporting
their contents in the register watch tool (while polling).

The register watch tool can be very powerful if applied well. Repeat the steps to add register 5 to the tool
again, but select ‘Time’ in the format window.

The tool now displays register 5 twice. Data entered in either of the data fields will be transmitted to the
servo. On the next QuickControl polling cycle, the other field will be updated and contain a scaled version
of the edited field. This provides a convenient method for monitoring both SilverLode native units and the
QuickControl scaled engineering units.
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Register Based Motion Commands

Data Registers

Data Registers are used as data storage locations that may be used and modified by a host controller or
by internal functions. There are a number of 32-bit data registers available within the device. They
provide data storage for the parameters of register based commands. Some registers contain two
separate pieces of data. These values are stored as two 16-bit numbers, one in the upper 16 bits of the
register, and one in the lower 16 bits.

The standard motion commands (MRV, MRT, MAV, MAT) all have corresponding register and extended
register versions. The trajectory for each of these moves is entirely pre-calculated; the contents of the
register(s) are checked only once when the command is issued. Changing the value of the register(s) has
no impact on a move already in progress. All values stored in the registers used by these commands
must be in native units.

Register Moves

(RRV, RRT, RAV, RAT) These register commands are the same as their standard counterparts, except
that the first parameter (position/distance) is a register number, rather than a value. The value in the
register, at the time of execution, is used to generate motion.

Extended Register Moves

(XRV, XRT, XAV, XAT) The extended register version of the standard motion commands take three
registers as parameters. The first specified register is used as the position/distance parameter. The
following two registers are used for the second two parameters.

A SilverLode servo has other register based motion types. They are even more powerful, with changes in
register values being applied on the fly. These commands are covered in detail in other chapters.
Following is a quick listing of these command types.

Profile Moves
All Profile Move commands (PMV, PMC, PMO, PMX) use the contents of registers 20-24 as parameters.
See chapter 3 for more information on Profile Moves.

Registered Step and Direction (RSD)

This command is operationally the same as Scaled Step and Direction (SSD), but the scale factor is
retrieved from the specified register, to allow dynamic scaling. See chapter 4 for details on Step and
Direction commands.

Input Modes

Three commands, Position Input Mode (PIM), Velocity Input Mode (VIM), and Torque Input Mode (TIM),
are used to access three special operating modes. The Input Modes use seven data registers for
processing position, velocity, and torque information. They allow the servo to use data from an analog
input or an external host to directly control motion. For example, this a good way to configure the servo
to respond to a joystick or analog input. These powerful commands are beyond the scope of this
document. See Application Note " QCI-AN047 Input Mode - Joystick".
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i1 Simple Register Based Motion
Qj?j The servo will execute two moves depending on the state of the I/O #1 and I/O #3. The program runsin a
continuous loop monitoring the two inputs. If data in the User Registers is modified, the motion profiles of
the moves can be changed.

1. Select File > Open. Navigate to the “..\QCI Examples\Using Inputs for Move Selection\” folder and select the
file “Two Inputs Two Moves with RRV.qcp”.

2. Open the Register Watch Tool (Tools > Register Watch). Press the “Add Register” button, select User [25],
select Position for the Data Format, and press OK. Press the ‘Add Register’ Button again, select User [26],
select Position for the Data Format, and press OK.

3. Press the “Download/Restart” button to download and begin execution of the program. Once the program is
downloaded press the OK button.

4. Notice the values placed in the selected Data Registers by the program. Toggle 1/O #1 LOW, then back to HIGH.
The servo will execute a simple move.

5. Toggle I/O #3 LOW/HIGH. The servo will execute a different move.

6. Click oncein the Data column of the User [25] Register. Enter the value 10 “revs” into the cell and push the
Enter key on the keyboard. Toggle I/0 #1 LOW/HIGH.

7. Click once in the Data column of the User [26] Register. Enter the value -100 “revs” into the cell and push the
Enter key on the keyboard. Toggle 1/0 #3 LOW/HIGH.

8. Experiment with different values for the registers used in this position control example.

9. When finished close the active program.

Question: What type of applications can this program work in?

fi.1 Complete Register Based Motion
ﬁ The purpose of this exercise is to get familiar with the basic XRV, JMP, and JOl commands. The servo will
execute two moves depending on the state of the I/O #1 and I/O #3. The program runs in a continuous
loop monitoring the two inputs. The complete motion profile of each move can be changed if data in the User
Registers is modified.

1. Select File > Open. Navigate to the “...\QCI Examples\Using Inputs for Move Selection\” folder and select the
file “Two Inputs Two Moves with XRV.qcp”.

2. Open the Register Watch Tool (Tools > Register Watch). Delete all listed Data Registers. Press the ‘Add
Register’ Button, select User [25], select Position for the Data Format, and press OK. Press the ‘Add Register’
Button again, select User [26], select Acceleration for the Data Format, and press OK. Press the ‘Add Register’
Button again, select User [27], select Target Velocity for the Data Format, and press OK.

3. Press the ‘Add Register’ Button, select User [28], select Position for the Data Format, and press OK. Press the
‘Add Register’ Button again, select User [29], select Acceleration for the Data Format, and press OK. Press the
‘Add Register’ Button again, select User [30], select Target Velocity for the Data Format, and press OK.

4. Press the “Download/Restart” button to download and begin execution of the program. Once the program is
downloaded press the OK button.

5. Notice the values placed in the selected Data Registers by the program. Toggle 1/0 #1 LOW/HIGH. The servo
will execute a simple move.

6. Toggle I/O #3 LOW/HIGH. The servo will execute a different move.

7. Click once in the Data column of the User [25] Register. Enter the position value 100 “revs” into the cell and
push the Enter key on the keyboard.

8. Click once in the Data column of the User [26] Register. Enter the acceleration value 150 “rps/s” into the cell
and push the Enter key on the keyboard.

9. Click once in the Data column of the User [27] Register. Enter the velocity value 25 “rps” into the cell and push
the Enter key on the keyboard. Toggle I/O #1 LOW/HIGH.

Note: Acceleration Range is 0 to 277.78 rps/s. Velocity Range is O to 66.66 rps (4000 rpm).

10. Modify the Position User [28], Acceleration User [29] & Velocity User [30] data for the second move. Toggle
I/O #3 LOW/HIGH

11. Experiment with different values.

12. When finished close the active program, delete all registers on the register list & close the Register Watch
Tool.
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Program Debugging

QuickControl provides several debug tools to aid in program development.

Debug Mode
Enter Debug Mode by checking the Debug e Thread 1 Debug Toelbar
H Yiew Thread Ereakpoints:
checkbox in the Program Info Toolbar. Program Line A - r Dol ® Enable
o . . | Add [Crtl4] Edit (CrtlE] Single Step Trace | Beal-Time Trace | Single Step/Break
While in Debug mode, QuickControl will Insert [Critk] | Delete [Crt-D]
. . . Linet
highlight the program line as follows: Programs Oper Label | Command
Download| Download/Restart | 1:REM
. . X 2U/ES START “Wwait On Bit State
e Program Line Being Executed: Scaling | Download/Fun || ||2 Unil "1/0 #5" is HIGH/TRUE
Highlight Yellow and italic TLA Test Line | Fun w/a Donnload | e e e @
e Program Line Ready for Single P g . [ LA e
. . . ragram List
Step: Highlight White and bold LDw/FALSE
p-Highlie Pragram Name [0] =1 | |[amp Jump to "START"
TLA -
Single Step/Break

Press the Single Step button to download the active program and single step (or execute) the first line.
Every time Single Step is pressed, the next line will be executed.

If Single Step is pressed while a program is running, the program will break wherever it is and await a
Single Step command.

Single Step Trace
Press Single Step Trace to have QuickControl continually "push" Single Step button for you. This lets you
observe the program executing at a reduce speed.

If Trace is pushed with no program running, the active program will be downloaded and QuickControl
will start "tracing" the program.

Real-Time Trace
Press this button to trace the program in real-time. Due to the delays in serial communications, the Real-
Time Trace may appear to "skip" over lines.

Breakpoints
Multiple Breakpoints can be set in the program by highlighting the line and pressing F9. If the program
encounters a Breakpoint while doing a Trace, it will stop tracing and go into Single Step mode.

Select the Enable/Disable Breakpoints to Enable or Disable all Breakpoints.

Real-Time Breakpoints
For SilverDust only, the Breakpoints will stop Real-Time Traces and go into Single Step mode.

Real-Time breakpoints can be temporarily set and cleared while in Single Step mode. The next time the
program is loaded from non-volatile memory, the breakpoints will reset back to what they were a
download time.
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View Thread

The View Thread radio buttons allow users to debug devices running both Thread 1 and Thread 2
programs. Each thread can be debugged independently of the other thread. For example, the user may
select Real-Time Trace for Thread 1, use View Thread to switch to Thread 2, and start single stepping
through the current Thread 2 program.

Test Line
The Test Line button on the Program Info Toolbar is useful to send the selected program line to the
device as an immediate command.

Jump To Line

This feature is accessible from either the Programs menu or by right clicking on a line. If this command is
selected while in Single Step mode, program execution will jump to the selected line. This is very useful
if you want to “re-do” a specific section of code or test a section of code that is hard to get to.

&’ej Debugging a (QCP) QuickControl Program

This exercise is an introduction to the program troubleshooting capabilities of QuickControl. These
functions provide a powerful means to check the operation of a program, and understand how individual
commands execute.

The default QCI Examples folder is located at: C:\Program Files\QuickControl\QCI Examples

The Red Stop Hand Icon on the Main Icon Toolbar will allow the user to quit operation of any Tool.

Single Step

1. Using the File menu, open the following qcp program: “..\QCI Examples\Moves-basic\Move Examples.qcp”.

2. Check Debug on the Program Info Toolbar (left panel approximately half way down) to enter Debug Mode.

3. Press the Single Step/Break button on the Debug Toolbar. This will initiate the execution of the first command
found in the program.

4. Continue pressing Single Step/Break until the end of the program file. The line which is next to be executed
will be highlighted in yellow/blue, a line which is still executing will be highlighted in white/blue. Press the Red
Stop Hand Icon to stop the program.

Single Step Trace

Use the Single Step Trace tool on the same QuickControl program file.

1. While still in Debug Mode, click on the first line of the program, and then press Single Step Trace. This will
initiate an automatic step-by-step execution of the program commands, one line at a time.

2. The Trace tool will continue through the program until it reaches either a Breakpoint, a command error or the
end of the program. The program will run significantly slower than real time operation. When complete, press
the Red Stop Hand Icon.

Real-Time Trace
We will now use the Real-Time Trace tool on the same QuickControl program file.

1. While still in Debug Mode, click on the first line of the program, and then press Real-Time Trace. This will start

the program, running at normal speed while highlighting the current line as time allows. As the program can
proceed faster than the serial port can, report the events, not all lines will highlight unless the program dwells
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on them for a sufficiently long time, such as delay commands, wait on inputs, or motion commands. The
advantage of Real-Time trace is that it is real-time - it does not slow down the execution.

2. The Trace tool will continue through the program until it reaches either a Breakpoint, a command error or the
end of the program. When complete, press the Red Stop Hand Icon.

Breakpoints
Breakpoints are set on lines by highlighting the desired line and selecting Toggle Breakpoint from the Programs

menu. The line should change color to Red. The function key F9 is a shortcut to toggle breakpoints on & off. Break
points are stored into non-volatile memory, but are only acted upon if breakpoints are enabled. Temporary break
points can be set when a program is paused in single step mode. The temporary breakpoints only remain while the
same program is in the command buffer and go away if a new sub program is loaded. The breakpoints downloaded
to non-volatile will be saved with the program. Breakpoints allow you to run a program in real-time until the
section of interest is reached.

1. Set a breakpoint on line 6 and press Single Step Trace. QuickControl will step through the program and then
stop at the selected breakpoint.

Test Line
The Test Line tool allows any one line in a program list to be executed. It only Tests (executes) the selected line

(command) and does NOT run the entire program.

1. Press the Red Stop Hand Icon.

2. Using the same open qcp program file, click on a MAT: Move Absolute, Time Based command and then press
Test Line on the Program Info Toolbar.

3. QuickControl should have executed the chosen command without executing other commands.

Jump to Line
When the program is paused in single step/break mode, right clicking on a desired execution continue point and

selecting Jump to Line will cause the program to continue running from the new selected line.
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fi.1 Cut, Copy & Paste Programming
@?j This exercise provides the user a technique for building up an entire motion profile. Several QCI
Example programs are opened up and the entire list of commands is copied into a “New” program.

1. Select File > Open. Navigate to the “...\QCI Examples\Homing\” folder and select the file “Homing against a
hard stop.qcp. Select File > Save As. Enter the filename testfile.qcp.

2. Select Programs > Program Details. Edit the program name to be “home”.

3. Select Programs > New Program. Enter the program name, “move”. Repeat again using the program name
“PMV”.

4. Verify all three (3) programs are in the Program List of the Program Info Toolbar. Click on the small down
arrow button to see the list contents. If all three are listed, save the file again. If all programs are not listed,
repeat Step 3, then save the file.

5. Select File > Open. Navigate to the “..\QCl Examples\ Profile Moves\” folder and select the file “Profile Move
Continuous.qcp”. Select Edit > Select All. Select Edit > Copy.

6. Select Window > testfile.qcp. From the Program List, choose the “PMV (2)” program.

a. Highlight line 1 - REM.

b. Select Edit > paste. The Profile Move Continuous program should be visible.

c. Highlight the last line of the program.

d. Press Add, choose the Flow tab, double click on the LRP command, press the button, and choose the
“home” program. Select File > Save.

e. Click oncein the Label column of the new LRP command. Enter the text “home” and push the Enter
key on the keyboard.

f.  Put alabel on the first line of the program by clicking in the "Label" column and typing the label name
in. Type “PMV”. Now, highlight the last line of the program.

g. PressInsert, choose the Flow tab, and double click on the JOI - Jump on Input command. Choose
“HOME” from the Program List. Press the Conditions button, choose “I/O #3” from the Condition list
and “LOW / FALSE” as the State. Press OK twice to get back to the program.

h. Highlight the last line of the program. Press Insert, choose the Flow tab, and double click on the JMP -
Jump command. Choose “PMV” from the Program List. Press OK to return. Select File > Save.

7. From the Program List, choose the “home (0)” program. Highlight the last line of the program.

a. Press Add, choose the Flow tab, double click on the LRP command, press on the button, and choose
the “move” program. Select File > Save.

8. Make sure all inputs are in the HIGH state and press the “Download/Restart” button to download and begin
execution of the program. Once the program is downloaded press the OK button.

Review: The program begins by running the homing to hard stop program, followed by the Profile

Move Continuous program. The program will continue to run until I/O #3 = LOW, then the entire
process repeats. Press the Red Stop Hand Icon to end.
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Chapter 3: Unique Features and Commands

Status Words

QuickControl comes with a diagnostic toolbar for real time status updates of the device, for ease in
troubleshooting any potential programming or physical issues that may arise. Three special status words
provide a wealth of information about the operating state of the device: the Polling Status Word (PSW),
the Internal Status Word (ISW), and the 1/0 Status Word (10S). The information contained in the 16 bits
of these words can provide information not available anywhere else.

Polling Status Word (PSW)
The Polling Status Word indicates the overall condition of the device. The meaning of each bit in the
Polling Status Word (PSW) is explained in the table below. The description for each bit describes the
device condition indicated by a “1” in that bit.

Bit# | Latched? | Definition Description
15 Yes I-Cmd Done Immediate Command Done (i.e. Host Command).
There was a checksum error while reading data from or to the non-volatile
14 Yes NV Mem Error . . . . .
memory. (SilverDust Rev 06 adds write protection to certain regions.)
13 Yes P-Cmd Done All commands active in the Program Buffer finished executing.
There was an error associated with the command execution. Unreasonable
12 Yes Command Error . g
parameter values or not support in this firmware
11 Yes Input Found The motion ended when the selected exit/stop condition was met.
10 Yes Low/Over Volt A low or over voltage error occurred.
9 Ves Holding Error Holfilng error.llmlt set by the Error Limits (ERL) command was exceeded
during a holding control state.
. Moving error limit set with the ERL command was exceeded with the device
8 Yes Moving Error . .
in a moving control state.
7 Yes Rx Overflow Device serial receive (UART) buffer overflowed.
6 Ves CKS Cond Met A con.dltlon was met while executing a CKS command. One of the conditions
set with the Check Internal Status (CKS) command was met.
5 Ves Msg Too Long The received message was too big for the Serial Buffer. Device rx packet > 31
bytes
4 Ves Framing Error Th.er.e wa§ a packet framing error in a received byte. Device rx byte with
missing bit.
The device was shut down due to one or more conditions set with the Kill
3 Yes Kill Motor Motor Condition (KMC) command (or KMX command for SilverDust Rev 06).
Latched yes, but after CPL it clears even if there is still a KMC till present.
2 Yes Soft Limit A soft stop limit was reached as set by the Soft Stop Limit (SSL) command.
1 Ves Rx Checksum Device rx packet with an invalid checksum. Valid for 9 Bit Binary and Modbus
only.
0 Ves Aborted Pkt There was a data error or a new packet was received before the last packet

was complete.
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The PSW is used to give the host a quick status update. A host may be programmed to act on changes in
the PSW, or the word could simply be used to alert the host to changes in the operating condition of the
device. The Polling function (POL Command) continually checks the PSW and is a common way to
update an external host on the condition of the device. Two Immediate commands are associated with
the Polling Status Word: the Poll (POL) command and the Clear Poll (CPL) command. The SilverDust (Rev
06) adds an additional command, the Poll with Response (POR).

Poll (POL) Command

The POL command is used to determine the condition of the device, by accessing the information in the
bits of the Polling Status Word (PSW). A POL command can be executed at any time, including while the
device is in motion. Executing this command will cause the device to return an ACK message if all of the
bits in the word are cleared, or return the word itself in hexadecimal if any of the bits are set. An ACK is
an Acknowledgement signal from the device that indicates that the command was received correctly
with no errors but no reply was required. The POR command (SilverDust Rev 06) operates similarly to
the POL command, but always returns a hexadecimal word, even if it is zero. See Technical Document
QCI-TD053 Serial Communications on our website for more information on Serial Communications.

Clear Poll (CPL) Command

All of the bits are latched, meaning that they must be cleared manually; they are not cleared when the
condition they are tied to clears. The CPL command is used to clear the bits of the Polling Status Word
(PSW). This command is the only way to clear the bits in the PSW since all the bits are latched.
Additional conditions that occur after a POL command is issued will show up when the next POL
command is issued, even if those bits have been cleared by an intervening CPL command (i.e. the data is
double buffered and the bits cannot be cleared until they have been read).

See Technical Document QCI-TD053 Serial Communications on our website for more information.
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1/0 Status Word (10S)

The 1/0 Status Word (I0S) indicates the states of the I/0 lines, as well as several specific internal
conditions.

The meaning of each bit in the I/O Status Word (10S) is explained in the table below. The description for
each bit, except Bit 7, indicates the condition indicated by a “1” in that bit.

Bit# | Latched? | Definition Description
15 No 1/O #7 Status of 1/0 line #7 (normally high, low when triggered).
14 No 1/O #6 Status of 1/0 line #6 (normally high, low when triggered).
13 No 1/O #5 Status of 1/0 line #5 (normally high, low when triggered).
12 No I/0 #4 Status of I/0 line #4 (normally high, low when triggered).
11 Yes Reserved
10 No Delay Counter | Status of the Delay Counter. High when counting down, low when count is
. expired.
9 No Holding Error Holding error limit set with the Error Limits (ERL) command has been
exceeded with the device in a holding control state.
8 No Moving Error Moving error limit set with the ERL command has been exceeded with the
device in a moving control state.
Internal sensor determines over temperature condition and clears this bit
7 No Temperature Ok when true. Bit is shared by drive enable lines on 34 frame servos. (disable =
high, enable = low.)
6 No I/O #3 Status of I/0 line #3 (normally high, low when triggered).
5 No 1/0 #2 Status of I/0 line #2 (normally high, low when triggered).
4 No I/0 #1 Status of I/0 line #1 (normally high, low when triggered).
3 No Trajectory When the Trajectory Generator is active, the device is calculating motion.
Generator Active |(i.e. a move is in progress)
2 No External Index | An index mark on an external encoder has been detected.*
Found
1 No Internal Index | An index mark on an internal encoder has been detected.*
Found
0 No Index Found An index mark has been detected on the selected encoder (external or
internal).*

*Only one 120uSec cycle wide.

Note: Latched bits can be cleared using the CIS command.

This word is accessible in two ways: with the Read 1/0 States (RIO) Immediate command sent from an
external host, and through a large number of different Program commands that are available for flow
and motion control in programs. When accessed by a host, the 10S allows the host to view information
that can supplement the information available from the PSW. As with that word, a host could be
programmed to act on changes in the 10S or it could be used for monitoring. The 10S can be accessed
from the lower half of register 209. (SilverDust Rev 06) The I/O may also be configured by the host, even
while a program is running on the SilverDust by using the Configure 10, Immediate Mode (Cll).
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Read 1/0 States (RIO) Command

The RIO command is similar to the Poll (POL) command. It can be issued by a host to gain access to the
I/O Status Word (10S). The RIO command can be executed at any time and returns the hexadecimal form
of the 16-bit binary number that makes up the I10S. None of the bits are latched, so the number
returned with the RIO command will represent current information.

Jump and Motion Commands

Most jump commands used by programs use the 10S, while the most motion commands use the Internal
Status Word (ISW) for their stop conditions. The jump commands use the 10S to define the conditions
for the jump. The motion commands use the ISW to define basic stop conditions (for example, stop
motion if I/O #3 goes HIGH). Using inputs for program flow and motion control is discussed further in
Chapter 4.

Internal Status Word (ISW)
The meaning of each bit in the ISW is explained in the table below. The description for each bit indicates
the condition indicated by a “1” in that bit. ISW is the upper word of register 3.

Bit# | Latched? | Definition Description
15 - Reserved Reserved bit.
14 Yes Low Voltage Low voltage error has occurred. Defined by LVT command.
13 Yes Over Voltage Over voltage error has occurred. Defined by OVT command.
Wait Delay . . .
12 .
Yes Exhausted The wait delay timer has expired
11 Ves Input Found On | An input used as a stop condition was found during the last move. Latched
Last Move but automatically cleared on next move.
Halt C d . .
10 Yes @ Sc;r:tman The halt command (HLT) was received by the device.
9 Yes Holding Error Holding error limit set with the Error Limits (ERL) command has been
J exceeded with the device in a holding control state.
. Moving error limit set with the ERL command has been exceeded with the
8 Yes Moving Error . .
device in a moving control state.
Internal sensor determines over temperature condition and clears this bit
7 No Temperature Ok |when true. Bit is shared by drive enable lines on 34 frame servos. (disable =
high, enable = low.)
6 No I/O #3 Status of I/0 line #3 (normally high, low when triggered).
5 No 1/0 #2 Status of I/0O line #2 (normally high, low when triggered).
4 No I/0 #1 Status of I/0 line #1 (normally high, low when triggered).
Negati
3 No eg.a ve Result of the last calculation was negative. CLC command.
Calculation Result
Positi
2 No OS.I ve Result of the last calculation was positive. CLC command.
Calculation Result
1 No zero :(aelculﬂatlon Result of the last calculation was zero. CLC command.
0 Yes Index Found An index has been detected.

Latched bits can be cleared using the CIS command.

The ISW is available in a data register (upper word of register 3), making it very useful for
troubleshooting. An external host can use this status word in several ways. A host can use the Read
Internal Status Word (RIS) and Clear Internal Status Word (CIS) commands to work directly with the
Internal Status Word (ISW). A host checking the Polling Status Word (PSW) can access the ISW by using
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the Check Internal Status (CKS) command. Finally, a program can use the ISW by checking a data
register.

Read Internal Status Word (RIS) Command

The RIS command is similar to the RIO and POL commands. It is issued by an external host to gain access
to the ISW. The RIS command returns the decimal form of the 16-bit binary number that makes up the
ISW. Some of the bits are latched while some are not. The bits that are not latched represent the status
of the condition associated with them, while the latched bits function as flags to indicate that the
associated condition occurred at some time after the last time the flag was cleared.

Clear Internal Status Word (CIS) Command

The CIS command is used to clear the latched bits of the ISW and 1S2. Latched bits must be cleared with
this command in order to be reset. This makes the CIS command an important part of the Kill Motor
feature. See Technical Document QCI-TD052 Shutdown And Recovery on our website.

Check Internal Status (CKS) Command

Bit #6 of the Polling Status Word (PSW) shows the CKS status. This allows a host that is polling a device
to indirectly use the ISW just by polling. The CKS command sets the conditions that will trigger the
Polling Status Word bit. There are 15 conditions for the CKS command to match the 15 bits used in the
ISW. The conditions are toggled on and off and then combined with a logical OR. This means that if any
of the conditions set with the CKS are true, bit #6 on the Polling Status Word will be set. The purpose of
this is to add functionality to the Polling Status Word by allowing one or more conditions of the ISW to
be flagged. If a host detects that bit #6 on the Polling Status Word is set, the host could then check the
ISW—the host essentially checks the ISW and Polling Status Word using just the Polling Status Word.

[ Edit CKS:Check Internal Status ==
Select which conditions to check Press Hie buthons ba
change state ar here far
more help. Cancel |
Index Found  Dizable Moving Error - Disable
Last Calz Waz Zero Dizable Holding Error - Dizable
Last Cale: Wag Positive Digable Halt Cornmand 'Waz Sent Dizable
Last Calz “as Megative  Dizable |rput Found On Last Move  Disable
"I/0 1" Dizable Delay Counter Exhausted  Dizable
"0 82" Dizable OwerYoltage  Dizable
"I/0 #3" Dizable Low Waoltage  Dizable
Temp/Drver Enable  Dizable
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Internal Status Word 2 (IS2) Description
The meaning of each bit in the IS2 is explained in the table below. The description for each bit indicates
the condition indicated by a “1” in that bit. IS2 is the upper word of register 236.

Bit# |Latched? |SD Definition Description

15 No 6 1/0 #7 1/0 #7 bit

14 No 6 1/0 #6 1/0 #6 bit

13 No 6 1/0O #5 1/0 #5 bit

12 No 6 1/0 #4 1/0 #4 bit

11 No 25 Thread 2 Running Thread 2 Running

25 CAN Communication Error

10 No CAN Comm Error
See 2000h Critical Error Mask in CANOpen® User Manual
for details.

6 Check data passed through the isolation barrier to the

? ves Extended 10 Fault extended IO and back to the processor was corrupted.
Indicates loss of 24v 10 power and or ground.

6 Encoder signals analog levels out of specification,

8 Yes Encoder Fault indicating the connector is loose or not connected, or
signals are open, shorted, misconnected, or having
excessive interference.

7 Yes 6 Drv Temp Fault-Digital Driver internal sensor indicates over temperature.

SN N3: Over current and over temp

6 Yes 11 H/W Drv Disabled HIGH = Driver Enable Line LOW=Driver Disabled

LOW = Driver Enable Line HIGH=Driver Enabled
- 11 Drv Temp Fault-Analog | SN N3: Driver analog sensor indicates over temperature.

4 Yes 11 Motor Temp Fault Temperature sensor in motor (I-Grade, IP-65) indicates
over temperature.

11 Driver disabled during Factory Block execution (startup)
due to one of the following conditions:

3 No* Fac Blk Drv Disabled

e  Motor miss-match: Attached motor type does
not match what controller was initialized for.
e Badread/bad data in motor memory.
6 Excessive lost encoder pulses detected between index

2 Yes Encoder Re-phased pulses. Encoder-motor phasing redone. May be excessive
noise, encoder problems, or wiring problems.

11 HIGH indicates that motion is being limited by one of the

1 Yes Motion Limit Fault following:

e  Soft Stop Limits (SSL)
e Velocity Limits (VLL)

0 No 8 Count Down Timer Active | HIGH indicates Millisecond countdown register (Register

245) is not zero.

Latched bits can be cleared using the CIS command.

*Bit reflects Factory Driver disable bit and is not cleared by a Clear Status Word command.

32




Internal Status Word 3 (I1S3) Description
The meaning of each bit in the 1S3 is explained in the table below. The description for each bit indicates
the condition indicated by a “1” in that bit. IS3 is the lower word of register 203.

Bit# |Latched? |Definition Description
15 No Reserved
14 No Reserved
13 No Multi-Tasking Active 1=active
12 No Driver Enabled 1 allows driver to remain on while in Kill Motor Recovery
at KMR Entry program if multitasking is active when fault occurs.
. . 1=driver disabled via enable/disable command or
11 No Driver Disabled-DMD
because of fault.
10 No Reserved
9 No Reserved
8 No Reserved
7 No Reserved
6 No Anti-Hunt Mode 0=Standard, 1=Allow Anti-Hunt while motion active
5 No Servo Loop Mode Mode set by Closed Loop Mode (CLM) command
0=Position, 1=Velocity
4 No Index Phase Alignment |Index Phase Alignment was enabled during initialization
3 No Reserved
2 No Index Phase Alignment | 0=Normal, 1=realignment from index has occurred
Fault (normally due to encoder counts lost)
1 No Reserved
0 No Reserved
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Internal Status Word 4 (1S4) Description (SD 05)
The meaning of each bit in the IS4 is explained in the table below. The description for each bit indicates
the condition indicated by a “1” in that bit. IS4 is the lower word of register 236.

Bit# | Latched? | Definition Description

15 No Reserved

14 No Reserved

13 No Reserved

12 No Reserved

11 No CAN HW Present CAN only enabled if CAN hardware is present

10 No Extended IO HW Enabled |8 or 16 bits of extended |0

9 No Reserved

8 No DC Motor Mode Enabled |Set by DC motor mode command

7 No CAN Rotary Switch Present | 1=hardware present

6 No Thread 2 Running 1=Thread 2 running

5 No Reserved

4 No PVIA Vel & Acc O=Filters,1=Observer

3 No Driver Disabled by Factory |1=disabled. Motor type indicated from motor memory does not

Block Fault match motor type configured in SilverDust.

2 No Breakpoints Enabled Allows breakpoints flagged in code to trigger break

1 No Encoder Runout Adjustment | Encoder runout has been calibrated, and is in operation.

0 No Index Phase Alignment - | At least one index pulse has been detected since closed loop,

Extended 10 Word (XIO) Description (SD)

The SilverDust D2-IGB provides 16 additional I/0, and the D2-1G-8 provides 8 additional 10. The input
and output state of these 10 are available in Register 238. The upper word provides the debounced (See
DIF command) levels read back from the extended 1/0, while the lower word provides the commanded
levels sent to the I/0. The upper word reports a voltage at the 1/O pin of greater than 1.5vas a1 and
below 1.5v as a 0. The lower word reports the requested drive level of the extended 10: a 0 indicates
that the output is off (floating), while a 1 indicates that the output is active (pulling the 10 to ground).
This register may be read, written, or modified by the host using standard register commands. 10 may
also be individually set using the various |0 commands. Note that the lower word (output) will retain the
written data, while the upper word will return to the actual detected levels the following cycle.
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Error Limits and Drag Mode

The ERL command is used to change four settings. It sets the moving and holding error limit conditions,
sets the delay time for switching from moving torque to holding torque, and enables or disables a
special operating mode called Drag Mode. Drag Mode helps eliminate servo wind-up and allows the
device to emulate a mechanical slip clutch.

Error Limits Command Parameters
The Moving Error Limit, Holding Error Limit, and Delay to Holding time are all set by the ERL command.

The three parameters determine the conditions under which the device reports a moving or holding
error. A SilverLode servo reports a holding or moving error by setting a bit in the Internal Status Word,
the 1/0 Status Word, and the Polling Status Word. There is a separate bit in each status word for moving
and holding error. The Delay to Holding Time is intended to set a delay following a motion for the
system to settle to a smaller error limit following the motion.

Error Limits Operation

A SilverLode servo applies moving torque whenever the Trajectory Generator is active. While the
Trajectory Generator is active, the servo compares the position error with the moving error limit.
Position error is calculated by subtracting the target position (set by the Trajectory Generator), from the
actual position (read from the encoder or external feedback device). If the magnitude of the position
error exceeds the moving error limit, the moving error bit in the three status words is set. The bit in the
Internal Status Word (ISW) may be used to automatically shutdown the servo (see Technical Document
QCI-TD052 Shutdown And Recovery on our website), while the bit in the Polling Status Word (PSW) and
I/0 status Word (I0S) can alert an external host to the error condition if the device is being polled.

At the end of a move, the Trajectory Generator goes inactive and stops changing the target position.
When this happens, the device starts the Delay to Holding timer set up with the ERL command. Until this
timer expires, the device continues using the moving torque limits and checking the moving error limit.
After it expires, the device applies holding torque and uses the Holding Error Limit to check for a

position error while holding position. The holding error is reported using a holding error bit in the three
status words.

Drag Mode
Servo systems can suffer from a problem called “position

wind-up”. This condition occurs when a servo motor cannot [ Edlit ERL: Error Limits

keep up with a move or is stalled by a mechanical jam.

When the jam is released and the shaft is free to move Ok

again, the position error can be huge, and the servo might Cancel

spin at a very high speed to catch up. This high-speed

[t

. . . b oving Error Limit | 100 counts ipti
reaction occurs because of the basic torque calculation that . Description

virtually all servo motors (including SilverLode servos) Halding Error Limit |20 counts Urits
perform as part of their control equation. If position error is Delay ta Haolding |83 mSec * Marmal
very large, then so is the torque response. The simplest way - ™ Mative

to prevent this response is to shut down the servo motor.

This may be fine if the shutdown is due to a jam, but there
are cases where a shutdown is not acceptable.
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An alternative to shutdown would be to limit this position error so it never becomes large enough to
cause a problem. Drag Mode allows the control algorithm to forgive excessive position error and
prevents extreme motion. Setting smaller error limits with drag mode enabled allows the unit to “slip”
when the error is exceeded emulating a slip clutch.

Drag Mode is enabled with the ERL command. In Drag Mode, when an error limit is reached (moving or
holding), the device adjusts the target position so that it differs from the actual position by no more
than the error limit. However, this can cause the final position to fall far short of the original target
position if one of the basic move commands is used (MRV, MRT, MAV, or MAT). Profile Move
Commands, eliminate this problem and the original target is achieved even with Drag Mode enabled.
This compatibility with Drag Mode is one of the benefits of using Profile Move commands.

Note, the Holding and Moving status bits are still set in the Internal Status Word (ISW) and will cause a
shutdown if they are used in the kill motor condition commands KMC and/or KMX. Profile Move
Operation

The Profile Move commands add a new dimension to the servo by allowing the move parameters to be
changed while a motion is in process. This gives the servo the ability to create custom motions as
required.

Profile Move commands can perform very complex motion profiles by allowing the move parameters to
be changed dynamically. Move parameters (stored in Data Registers) can be changed by an external
Host controller or by an internal program.

There are two Profile Move commands:

1. For asingle move; use the Profile Move (PMV) command to execute a single move where the
command ends when the target position is reached.

2. For a continuous move; use the Profile Move Continuous (PMC) command to execute a move
that does not stop when the target position is reached. Once in position, this operation will wait
until the position parameter is changed so there is no need to reissue a move command. Multi-
Tasking must be enabled for PMC to function properly. This continuous move can be terminated
with a Stop on Input condition, or the stop techniques mentioned previously.

Both Profile Move commands use Data Registers #20 to #24 for parameter storage. The Profile Move
commands use linear acceleration and deceleration parameters, where a separate deceleration
parameter is provided for different acceleration and deceleration profiles. The S-Curve Factor (SCF)
command does not work with the Profile Move command. Profile Move commands also use an offset
parameter, which causes the servo to move an offset distance after a Stop on Input condition is met.

Zig:;:: Description | Comment

20 Position Absolute destination value.

21 Acceleration | Sets the acceleration rate that is used when increasing the move speed.

22 Velocity The maximum speed that is allowed during a move.

23 Deceleration | Sets the deceleration rate that is used when decreasing the move speed.
When a stop condition is met, this value is added to the current position and

24 Offset copied to Register 20 for a profiled stop. If set to zero, only the deceleration
values is used to ramp down to a stop.
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The Profile Move Override (PMO) command overrides any other motion currently in progress and
executes a PMV command, using the parameters loaded into the Profile Move registers (#20 to #24).
When this command follows a PMC command, the PMC operation will end when the target position is
reached, effectively changing the functionality of PMC command to act like the simpler PMV command.
Normally, the PMC command will not end unless explicitly stopped by a stop condition. Using the PMO
command after a standard PMV command will have no effect, other than using any new stopping
conditions contained in the PMO command. PMO will also override other modes if Multi-Tasking is
enabled (e.g. Step and Direction).

The Profile Move Exit (PMX) command will stop any profile move currently executing, bringing the servo
to a halt using the Profile Move deceleration register (#23).

Profile Velocity Continuous (PVC)

PVC accelerates to the velocity given in the second register of the register pair using the acceleration
from the first register of the register pair. During the move, either parameter may be updated, and the
motion will be modified accordingly. The registers may be modified either by a Host controller using the
serial interface or by an internal program if Multi-Task (EMT) is enabled. If Multi-Task is not enabled, the
program execution will hold on the PVC command. See PVC in the Command Reference for more details.

Note, since there is no position parameter, the servo is able to maintain the desired velocity indefinitely.
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ERL - Error Limits and Drag Mode Operation with MAV and PMV

This exercise demonstrates the effects Drag Mode has on motion from the Move Absolute Velocity

Based (MAV) and Profile Move (PMV) commands. Drag Mode adjusts the target position to keep it
within a certain number of counts of the actual position. The number of counts is determined by the
Moving Error Limit parameter of the ERL command. For example, if the Moving Error Limit is 500 and the
servo jams at position 2000 while moving in the positive direction, the target position will not exceed
2500, regardless of what the original target was. The entire motion profile of the MAV command is pre-
calculated by the device. It only moves the calculated time of the motion profile so the device will stop
short of the target position. In contrast, PMV will not stop short because it recalculates the motion every
servo cycle.

Note: This exercise requires the user to manually stop the motion of the shaft. A small flywheel attached
to the shaft makes this task easier. The torque limits must be set low, so it will not be difficult to stop the
shaft. Do not use higher torque motors (34 frame, for example), as even at a 30% setting the motor
torque can exceed finger/wrist strength! Leather work gloves are suggested, as is the avoidance of loose
clothing that could catch in the system! Please use caution.

1. Power up the device and start QuickControl. Start polling the motor and verify that the system is operating
properly.

2. Select File © Open. Navigate to “..\QCl Examples\Profile Moves\” and select the file, Absolute and Profile
Move with Drag Mode.qcp.

3. Notice the error limits set with the ERL command in line 3. Also note that Drag Mode is enabled with this
command.

4. Editthe TQL command in Line 7. Set the Closed Loop Moving and Open Loop Moving torque limits to 30%.
Press OK when done.

5. Select Tools > Register Watch. Press Add Register; select Target Position[0] and Position data format. Press
OK when done.

6. Repeat Step 5 but add Actual Position[1] and User | Profile Move Position[20]. Choose Position for the data
format for both.

7. Edit the Absolute Location data of Line 10 (MAV) to read +10,000 counts. Press OK when done.

8. Edit the Data value in Line 14 (WRP) to read -10,000 counts. Press OK when done.

Some examples of Drag Mode are:

* ASilverLode servo can be configured to emulate a mechanical slip clutch. For this application,
the ERL command is used to set the error limits and enable Drag Mode, and the Control
Constants (CTC) command is used to tune the response. When configured for this operation, the
servo will resist any external force on the shaft with a tunable amount of torque and will not fly
back to its original position when the external force is removed.

* If the shaft were jammed, the actual position would not change since the shaft would be stuck.
Drag Mode would freeze the target position until the jam was cleared, preventing the target
position from running away. The target position would freeze a number of counts away from the
actual position equal to the holding error limit.

* If the Trajectory Generator were commanding a move that was too fast for the motor to
physically keep up with (due to excessive load or insufficient torque), Drag Mode would limit the
target position runaway to a number of counts equal to the moving error limit.

* If the device were holding a position and the shaft was moved outside of the holding error limit,
Drag Mode would “drag” the holding target position along as the shaft was moved, preventing a
rapid move back to the original position when the shaft is released. A SilverLode servo would
only move the shaft back a number of counts equal to the holding error limit.
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Anti-Hunt™ Feature

Digital servo systems share a common characteristic called “dithering” or “hunting” when holding a
position. This occurs as any error causes the torque to build up until the motor overcomes friction and
stiction and the motor moves to correct; often the motor may overshoot by a small distance and the
process repeats. Dithering typically occurs when the holding position is near the count transition point
of the digital feedback device (i.e. optical encoder or resolver), causing the shaft to oscillate between
counts. For some applications, dither is desirable and may even be intentionally created. In other
applications the hysteresis required for the Anti-Hunt algorithms is not acceptable. For these
applications, disable the Anti-Hunt. In other applications, however, any dither is unacceptable and in
severe cases, can cause significant oscillations in the whole system structure or audible noise when no
motion is present. These applications benefit from Anti-Hunt.

SilverLode servos have a unique operation called Anti-Hunt that is designed to eliminate dither by
switching from closed loop control to open loop control. When using open loop control, the device
ignores any error feedback so small errors in position do not result in constant corrections. These
constant small corrections are what cause the servo dither during closed loop operation. In addition to
eliminating dither, the device can use Anti-Hunt to help smooth out some kinds of motion profiles by
using open loop control during some parts of the move. This section explains the operation of Anti-Hunt,
describes how to use it, and covers the commands used to set it up.

Using Anti-Hunt™

The servo can be set to enter Anti-Hunt only when holding a position, or it can be set to enter Anti-Hunt
any time position error is low enough. When using open loop control to hold position, the device ignores
small position errors and lets the shaft sit at the position it held when it stopped. When using open loop
control during a move, the servo ignores small errors and commutates the motor based only on the
motion profile from the Trajectory Generator. Both settings for Anti-Hunt can make the servo operate
more smoothly, but they also limit the final position accuracy.

Anti-Hunt is mainly used in two situations:

1) Holding position firm and steady without servo dithering.
2) A particular operation requires using open loop control for part of a move or hold.

If the accuracy of final position in an application requires strict compliance, Anti-Hunt may need to be
turned off because it creates a feedback deadband around the final position. When the shaft is
anywhere inside this deadband, the device ignores position feedback and it will not correct the final
position error. In general, open loop control should not be used during motion unless there is a specific
design reason (e.g. it eliminates dither in slow, high-inertia moves).

Anti-Hunt™ Commands

Five different commands are important to Anti-Hunt operation: Anti-Hunt Constants (AHC), Anti-Hunt
Delay (AHD), Anti-Hunt Mode (AHM), Torque Limits (TQL), and Error Limits (ERL). The AHC and AHD
commands set the conditions under which the device enters and exits Anti-Hunt, while the AHM
command sets the type of anti-hunt operation the device uses. The AHC, AHD, and AHM commands are
covered below.
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Anti-Hunt Constants (AHC) Command

The AHC command sets the conditions for the device to enter and exit Anti-Hunt. The AHC command

uses three parameters: Closed to Open error, Open to Closed error, and the Check Holding Currents flag.

The Closed to Open error parameter sets the point at which the
servo can enter Anti-Hunt and transition to open loop control.
A SilverLode servo can enter Anti-Hunt once position error is
equal to or less than this value. Position error is the difference
between the target shaft position and the actual shaft position,
measured in encoder counts.

The Open to Closed error parameter establishes the point at
which the servo exits Anti-Hunt and returns to closed loop
control. If position error ever equals or exceeds this value when
the servo is in Anti-Hunt, the device immediately exits Anti-
Hunt, switching to closed loop control to correct the position

Edit AHC: Anti-Hunt Constant

Open to Clozed

Amaunt of error required to go out of
Apti-Hurt,

|2EI counts

- —_—

Cloged to Open

Amount of error required to go into
Anti-Hunt.

|8 counts

- —_—

Ok
Cancel
Description

Test

clikg

Check,
V¥ Halding
Curents

Edit Mode
" Default

(" Disable
{+ Edit

error. Setting the Closed to Open and the Open to Closed
parameters to zero disables Anti-Hunt.

When the Check Holding Currents box is selected, as shown in the QuickControl screenshot, the servo

checks another condition besides position error before entering Anti-Hunt. The servo compares the
actual torque required by closed loop control (as indicated by the current flow through the motor

windings) to the open loop torque limit. If the closed loop torque required exceeds the open loop torque
limit, the servo will not enter Anti-Hunt. The servo does not compare the closed loop torque used to the
open loop torque limit if the Check Holding Currents condition is disabled.

The Use Default for Device checkbox is checked by default. This causes QuickControl to set AHC at

download time dependent on the device's encoder CPR.
See the Command Reference for more details.

Anti-Hunt Delay (AHD) Command

The AHD command sets the time delay the device uses before entering Anti-Hunt. This delay is useful for

allowing a system to settle (stop ringing) before switching to open loop control, since position error and
torque must remain within the limits set with the AHC command for the duration of the delay.

Anti-Hunt Mode (AHM) Command

The AHM command controls the operation of Anti-Hunt. Anti-Hunt
operates in one of two states, as shown in the QuickControl
screenshot. In its default state, the servo will only enter Anti-Hunt
when the servo is holding a position (meaning that the Trajectory
Generator is inactive). If this default setting is changed, the servo
can enter Anti-Hunt when moving or when holding position. This
means that the servo can switch to open loop control whenever
the position error is low enough, so an entire move could be
executed using open loop control.
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Error Limits (ERL) and Torque Limits (TQL) Commands

These commands are covered in their own sections, but are important for Anti-Hunt. When the target
velocity reaches zero, the ERL delay timer starts counting down. Until the timer expires, the control loop
limits torque according to the “Moving” limits, Closed Loop Moving, if in closed loop, and Open Loop
Moving if in open loop (including at position in Anti-Hunt. After the timer counts down to zero, the
“Holding” limits are used — Closed Loop Holding or Open Loop Holding, as set by the TQL command. If
the optional closed loop torque condition has been enabled with the AHC command (the Check Holding
Currents box in QuickControl), the servo will compare the closed loop torque being used to the relevant
open loop torque limit.

Anti-Hunt Operation

Anti-Hunt essentially sets up a open-loop deadband around the target position. Inside this deadband,
the servo uses open loop control and therefore ignores error feedback. The width of the deadband is
defined by the Anti-Hunt Constants (AHC) command. When the position error becomes low enough to
enter the deadband, the device performs some other checks (explained below) and then enters Anti-
Hunt. When the position error becomes too large, the device immediately switches to closed loop
control and exits Anti-Hunt. The Anti-Hunt deadband should be a different width depending on whether
the device is entering Anti-Hunt or exiting it. The exit deadband is normally larger than the entering one.

The servo checks several conditions before entering Anti-Hunt. The conditions checked before entering

Anti-Hunt are:

* Position error. The servo compares position error to the “Closed to Open” value set with the AHC
command. If the absolute value of the position error is less than or equal to the AHC value, this
condition is met and the servo can enter Anti-Hunt.

* Anti-Hunt delay timer. Once the position error is low enough, the servo starts counting down the
Anti-Hunt delay timer, set by the Anti-Hunt Delay (AHD) command. The servo does not enter Anti-
Hunt until the timer expires. This allows the servo to settle in before going to open loop. The timer
restarts if position error exceeds the closed to open limit set with the AHC command while still in
closed loop mode. If the closed loop torque condition (see below) is enabled, the transition to
closed loop can not happen until the closed loop torque being used drops below the open loop
torque limit.

*  Moving status (optional). When the Anti-Hunt Mode (AHM) command is set to its default value, the
servo only enters Anti-Hunt after the end of a move when it is holding a position. The end of a move
occurs when the Trajectory Generator goes inactive. In this default setting, the servo uses closed
loop control throughout the move. When the AHM command is set to the non-default value, the
servo can enter Anti-Hunt at any time, moving or stopped. This allows the servo to use open loop
control during a move if the other Anti-Hunt conditions are met.

Closed loop torque (optional). If the AHC command is set to its default state, the servo compares
the torque being used during closed loop operation with the open loop torque limit (the open loop
moving limit during a move, the open loop holding limit while holding position). If the closed loop
torque exceeds the open loop torque limit, the device will not enter Anti-Hunt. This extra condition
can be disabled with the AHC command. This would be used to implement conventional dead band
by setting the open loop torque

The servo checks only one condition to exit Anti-Hunt: position error. As soon as position error exceeds
the Open to Closed value set with the AHC command, the device switches to closed loop control in order
to correct the error. It then operates in closed loop control until conditions to enter Anti-Hunt are met
again.
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Multi-Tasking

A SilverLode servo can execute programs with multi-tasking either enabled or disabled. With multi-
tasking disabled (default), a program executes one command at a time. If a command starts a move that
takes twenty seconds to complete, the program will wait for twenty seconds before executing the next
command. With multi-tasking enabled, the move command will execute normally, but the program will
continue to the next command while the motor is still in motion. Please See Appendix 1, exercise 3.2 for
examples of Multitasking and a step by step sample program to get used to using this feature.

Multi-Tasking Operation Rules

The purpose of multi-tasking is to allow the device to continue to execute commands while a motion
command is running. The ideal way for this to happen would be for the Trajectory Generator to go
active as soon as a motion command is issued and for the next command in the program buffer to be
executed on the next servo cycle. In some cases, this is exactly what happens, but some motion
commands still stop program flow right after they are issued, just like a delay or wait command.
Different types of motion commands also work differently when multi-tasking is enabled. Please see
Appendix |, exercise 3.2 for a list of special cases and multi-tasking exceptions.

Multi-Tasking Operation

Multi-tasking enables the servo to continue executing a program while a motion is in progress. With
multi-tasking disabled, when the servo executes a motion command the program pauses execution until
the move is complete (i.e. the Trajectory Generator is inactive) or until a stop condition is met. With
multi-tasking enabled, the program continues to run during the move, allowing much greater versatility
in the program. The Enable Multi-Tasking (EMT) command enables multi-tasking and the Disable Multi-
Tasking (DMT) command disables it. Using multi-tasking correctly requires a firm understanding of how
the servo controls program timing, the system tasks that the servo executes in the background along
with program commands, and the ways the servo responds to different motion commands when multi-
tasking is enabled.

i1 Multi-Tasking for Advanced I/O Control
@£5 This example shows multi-tasking use with inputs and outputs during motion. In normal program
flow, each command executes in order, and the next command is not allowed to start until the
previous command has finished. The EMT - enable Multi Task command allows the commands following
a move command to be executed while the motion is still happening. Motion override commands can be
used to take over the current motion, while other motion commands will stall the execution until the prior
motion has completed. This program executes one of two Register Move Relative, Velocity Based (RRV)
commands, depending on the state of I/O #1 and #5. The values stored in registers 25 and 26 are used
as parameters for the RRV move commands. The loop is comprised of Jump (JMP) commands in an
infinite loop that execute continuously until one of the inputs is triggered low. Once an input is LOW, a
move is executed. If I/O #1 is LOW, the /O #2 will flash (turn ON/OFF) during the motion. If /O #5 is
LOW, the second RRV move will run and the 1/0 #2 will of HIGH.

1. Power up the servo and start QuickControl. Start polling the servo and verify that it is operating
properly. Ensure that I/O #1 is HIGH.

2. Select File = Open. Navigate to “...\QCl Examples\Multi-Tasking\” and select the file, Using Multi-
Tasking for Advanced 10 Control.qcp.

3. Press the “Download/Restart” button to download and run the program.

4. The servo run the program and wait in the “Forever” loop for an input. Toggle 1/O #1 or #5 LOW
then HIGH to select the “Movel” or “Move2” routines. If #1 is chosen, the output will flash three
times at the beginning of the move.
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Multi-tasking Exceptions and Interactions

Delays with Motion Commands. The time and velocity based motion commands (MRV, MRT, MAV,
MAT, RRV, RRT, RAV, RAT, XRV, XRT, XAV, and XAT) are all pre-calculated. This means that the device
uses the motion parameters specified with each command and calculates the entire trajectory for
the move before sending the calculated trajectory to the Trajectory Generator and actually starting
the move. During this calculation period, the device does not execute the next command in the
program buffer, even if multi-tasking is enabled. For the SilverNugget, this calculation period is up to
two milliseconds for the time-based moves and up to four milliseconds for velocity-based moves.
The Pre-Calculate move commands (PCM and PCG) allow some control over this delay period and
can be useful for some applications. The Command Reference has more information on these two
commands. The times for SilverDust and SilverSterling are significantly shorter.

Velocity and Time Based Motion Commands. When the servo executes a time or velocity based
motion command, it checks to see if the Trajectory Generator is busy (active). If another move is still
running, the program will pause until the prior motion has completed. This effectively stalls multi-
tasking. Once the first move finishes, multi-tasking begins working as expected again. This is one of
the most common errors encountered when using multi-tasking. Some other commands can
override the first motion command and unblock the program. The velocity and time based motion
commands can be overridden by the VMP, HSM, HLT, STP, PMO, or PMX commands. The override
commands read the velocity and target position of the motion in process and use those as the
starting point for their operation.

Velocity Mode Motion Commands. The velocity mode commands (VMP and VMI) do not pre-
calculate their moves, so program flow is not disrupted. They also do not check on the busy status of
the Trajectory Generator, so they will override any other move that is still executing. Setting the
desired velocity to zero and issuing the VMP or VMI command is the best way to do a controlled
stop on a move, because these two commands override the other move commands and because the
deceleration can be specified. A VMP or VMI command can be overridden by another VMP or VMI
command, a PMO command, or by an HSM, STP, or HLT command.

Note: the VMP command may be placed into a program, while the VMI command is only an
immediate command sent via the serial port at execution time.

Profile Move Commands. The profile move commands allow the device to follow a pre-defined
motion profile. Like VMP and VMI, the Profile Move (PMV) and Profile Move Continuous (PMC)
commands do not pre-calculate their moves. They can be overridden by other PMV and PMC
commands, by VMP and VMI commands, or by the PMO, PMX, HSM, STP, and HLT commands.
Moves using profile move commands can be dynamically changed by modifying the motion
parameters when multi-tasking is enabled or by writing to the registers via serial or CANopen.
Interpolated moves using the IMS command work like profile moves with respect to multi-tasking.

Step and Direction Commands. The step and direction commands allow the servo to respond to
direct motion commands from a host in a manner similar to a simple stepper motor (although the
device can still use closed loop control, unlike any stepper). Like velocity mode and profile move
commands, the Registered Step and Direction (RSD) and Scaled Step and Direction (SSD) commands
do not pre-calculate their moves. They can be overridden by other RSD and SSD commands, by VMP
and VMI commands, or by the PMO, HSM, STP, and HLT commands.

Input Mode Commands. The Velocity Input Mode (VIM), Torque Input Mode (TIM) and Position
Input Mode (PIM) commands allow the device to respond directly to the values in registers 12
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through 18. Like the last three motion commands, they do not pre-calculate their moves. The input
mode commands can be overridden by VMP and VMI commands, or by the PMO, HSM, STP, and HLT
commands. Input mode moves can also be changed on the fly by changing the values in register 12
to 18.

Hard Stop Move (HSM) Command. The HSM command immediately stops a move started by any

motion command.

* Stop (STP) Command. The STP command immediately exits the current program and stops any
active move using the specified deceleration (see STP in command reference for details).

* Halt (HLT) Command. The HLT command immediately stops any motion, sets the halt bit in the
Internal Status Word, and calls the Kill Motor Recovery program. When multi-tasking is enabled, the
motor drivers will remain active during the Kill Motor routine if the Kill Enable Driver (KED)
command has been issued. With multi-tasking disabled, the motor drivers are always disabled
during a Kill Motor routine, regardless of whether or not a KED command was issued. See Technical

Document QCI-TD052 Shutdown And Recovery on our website.

* End Program (END) Command. If multi-tasking is enabled and an END command is issued, the
device will finish the current move if a motion command is active, and then end the program.

Multi-Tasking Examples

The following examples illustrate how multi-tasking works with the programs.

Example 1: 1/0 Control During a Move

- : Linzes Label |C d

This program starts a 10-revolution MRV move, Oper abe Ormrnary

waits for a 1000 msec delay, then toggles I/0 bit #1 || 1:EMT _Enabls Multi-T asking
] . L iMove TOREY @

for 50 msec while the move is still in progress. The 2 MR

WBS command in line 7 causes the program to 3DLY D elay for 1000 mE oo

wait on that command until the move commandis | #COE Clear 140 #1"

| Th | bef bit #2 | 5:DLY Delay for 50 mSec
complete. The move completes before bit #2 is ESOB ot 10 H
cleared in line 8. This program sends an output wiait On Bit State
. . FhiBS Irtil "' T rajecton Active' iz
signal when the move is finished, but also allows Lo /FALSE
other commands to be executed before the WBS EHERE Clear U140 827
S.EMD End Program

command holds the program while the move

finishes. Several non-motion commands could be inserted between lines 2 and 7 that would all execute

during the MRV move.

Example 2: Multi-Tasking Motion Command

Buffering :iigz:i Label | Command
Multi-tasking will have no effect in this program. T-EMT “ T E rable Multi-Tasking
Since time and velocity based motion commands are Move 10 revs @
2 MRV acc=2 1pads
buffered, when the second MRV command is wel=5 rps
. . Move 10 reve @
encountered, the program stalls until the first MRV TMRAY acc=2 1psds
P . . wel=h 1ps
command is finished executing before starting the LEND End Program

second MRV and continuing with the program.
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Example 3: Multi-Tasking Motion Command Transitioning

In this next program, the servo begins the MRV

move and then delays for 3000 msec before H;g? Label | Command
continuing with the rest of the program. After the 1-EMT Enable Multi-T asking
delay time, the device executes the VMP command Move 10 revs @
- . . ZMAY acc=2 rpads
in line 4. As explained previously, the VMP vel=F ps
command overrides all other motion commands, so 0Ly Delay for 3000 mSec

; : . Welocity Mode:
this command prematurely ends the move from line 4P acc=d s/, vel=20 s
2 and accelerates the motor to turn at 20 5END Erd Program

revolutions per second.

Multi-Thread

Multi-Thread allows the user to simultaneously run two programs. Thread 1 is the primary program,
which runs after a power on or reset condition, and is capable of all commands except T1F — Thread 1
force (Causes a LRP command to be executed within Thread 1). Thread 2 is invoked from Thread 1; the
invoking command specifies how much of the Program Buffer to allocate to Thread 2, and where the
new Thread 2 program is stored in the Non-Volatile memory. The allocated memory + 1 location are
subtracted from the top of Thread 1 Program Buffer space. Thread 2 executes with the start of its
Program Buffer at O, just like Thread 1. Thread 2 is not able to execute motion commands to prevent the
resulting confusion, but it is able to do 10 and calculations.

While the second thread is running, Thread 1 gets executed every 240 us and Thread 2 gets executed
every 240 s, on alternating 120 ps intervals.

Thread 2 is able to read and modify registers, 10, and to use CAN functions. It cannot execute any
command which affects the Trajectory Generator (i.e. motion), nor is it able to invoke a new Thread 2 or
change its buffer allocation.

To simplify programming, each thread has its own private register 10 (Accumulator) as this register has
special uses; Thread 2’s register 10 appears as register 248 to Thread 1 and the outside world. Each
thread also has its own Zero/Negative/Positive condition flag storage.

A status bit (BIT 11) in IS2 is provided to monitor Thread 2, with a high level indicating that Thread 2 is
active. The Kill Recovery Extended (KMX) command may be used to cause Thread 1 to automatically
respond to the loss of Thread 2. (Such as shutting down Thread 1 if Thread 2 is performing a safeguard
function and dies.)

Thread 2 Kill Conditions (T2K) command specifies which conditions kill Thread 2 and which it will survive.
These include Kill Motor (which affects Thread 1), Over Voltage, Under Voltage Driver, Under Voltage
Processor, Halt command, and Stop command. The default condition is to halt Thread 2 on any of these
conditions unless the user specifically configures Thread 2 to ignore them.

Just as Thread 1 can startup a Thread 2, Thread 2 can force a new program upon Thread 1, acting much
like a software invoked Kill Motor Recovery routine. Thread 1 is also capable of stopping Thread 2;
Thread 2 also ceases if it encounters an END command. The time slice and the command buffer space
are returned to Thread 1 if Thread 2 execution ceases.
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If a Thread 1 only command tries to execute in a Thread 2 program, Thread 2 will shut down and
produce a Command Error Code #17 (see Appendix C). All other Command Errors Codes for Thread 2
errors are their respective Thread 1 Command Error Code plus 64 (0x40).

Note: CIS (Clear Internal Status) clears the common register, so be careful if this command is used in

both threads.

The Delay counter, used in DLY, DLT and WDL, is common to both threads, so use it in only one thread or
the other. For timing in the other thread, use the Count Up Timer (reg 244) or the Count Down Timer

(reg 245).

Using QuickControl To Launch Thread 2

Thread 1 and Thread 2 programs are written normally and exist as programs within the same program
file (same QCP). The following is an example (QCI Examples\Multi-Thread\Multi-Thread.qcp) contains a

Thread 1 and Thread 2 program.

lﬁ';g? Label | Command EIEEF Label | Command
1:REM ) Thread 2
5.730 Start Thread 2 with 1-REM Flazh Dutput
: Pragram = "Thread 2" ZREM LOOFP  Main Loop
IREM ko forward and back 3COB Clear "I/0 #102"
Move to 4000 counts & 4:DLY Drelay for 500 mSec
4:MAT LOOF  ramp time=50 mSec 5S0B St /0 H102"
tatal ime=200 mSec
G:0LY Drelay for BO0 mSec
Move to [ counts (@ 7 IMP J ta "LOOR"
DMAT ramp hime=50mSec : urmp ta
tokal time=200 mSec S:REM End
BlkP Jurnp e "LOOP" 3REM
Thread 2 Thread 1

Thread 1 Program is the main program (program 0) and runs at power up. The T2S command allocates
Thread 2 Program Buffer space and launches the program "Thread 2". In the example above, Thread 1
Program then executes a loop that moves the servo from 4000 counts to 0. Thread 2 Program

simultaneously executes a loop the "flashes" output #101.

In order to allow a program to be run in thread 2, it is necessary to

tell QuickControl that it is a Thread 2 program. This is done by
going to Program Details from the Programs menu and checking
the Thread 2 checkbox.

The amount of Program Buffer allocated to Thread 2 is
calculated automatically by QuickControl or can be set
manually by the user. If calculated by QuickControl, it is set to
the largest Thread 2 program in the file. To manually set the
Program Buffer allocation, select Program File Properties
from the File menu. In the Program File Properties dialog box,
uncheck Thread 2 Auto and enter the amount of words to
allocate to Thread 2. The example shown allocates 300 words

of the Program Buffer to Thread 2.

Program Details

Progian Name

Thiead 2

Desciption

i

Cancel

Mermary Management
anually Set Address r
Store Program into

[Enter description here

« | Monolatie Memory 516
starting at
4335

Nonfolatie
ES

Memary Size:

=

Percent Used

Thread &

Program Index
Change Progiam Index to
change program order.

<l

—

Program File Properties

Seale

Cancel ‘

Scale equals courts/position unit Scale 1

Encoder Counts/Rev [CPR) Ace (048
2000 ~| GaCPR vel [a027

Enter the label to be usedl in Move Units W

type command [ie. "evs")
#Dec

Number of Decimal Places to
Places

display

0

Fiegister Names ‘ 1/0 Names

Description

[ir3
Min/Max

Pos Min  [:2147483647 counts
Pos M [2147483647 courts
velMas  [100 %

533333 ps
AccMax 01 %

2007322 cpsfs
Max Time: 10000 mSes

Upload
Passward
Soit Progiams in download order [

1234 410 Chars

Only allow Run wéo Download [

Update Device Status Propeties [
anviime this fle s active

Thread 2
Program Buff Size | 300

I Auto
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Specialty Commands

Calculation (CLC)

CLC:Calculation @
The CLC command provides basic math and logic
Ok
functions. %
Calculation TWO word (CTW) Register | Accurnulator [10] I Description |
The Calculation Two Word (CTW) command is Operaton [Desremert (g = ieg 1] |
identical to CLC except that it requires an extra word

of memory that makes it easier to create for a host
(see Command Reference for details).

Many programs require operations to modify values stored in data registers, manipulate binary
numbers, or aid in programs using loops. Three different kinds of operations are accessible with the CLC
command. The first group of operations is basic math functions. These include add, subtract, multiply,
divide, absolute value, increment, and decrement functions. The second group contains binary logic and
number manipulation functions, which include the bitwise AND, OR, and XOR functions, as well as
several bit shift functions. The third group contains data register and accumulator manipulation
functions. These operations are used to move data to and from the accumulator register and to load,
store, and manipulate data in the data registers. Operations of the CLC command are accessed from a
pull-down list. See Command Reference for details.

Calculation Extended (CLX) and Calculation Extended With Data (CLD)
Three parameter versions of the Calculation (CLC) command that allow for such things as adding two
registers and storing the result in a third register. Available on SilverDust and SilverSterling.

WCW and WCL Commands

The Write Command Word (WCW) and Write Command Edit WCW:Write Command Buffer Word ==
Word Long (WCL) commands are two of the most
powerful commands available. The WCW and WCL Register Cancel
commands are extremely powerful commands that accnulato ] | Description
should not be used until fully understood, but which can Command to Wiite To

add a new degree of flexibility to programs or host Label [FE ]
applications. They allow a program to modify itself by Command [CI0:Configure 170

overwriting data in the Program Buffer. They turn any .
command that requires a data parameter into a register- Mode

based command. A SilverLode servo does not do

extensive error checking on the data that is changed, potentially making these commands very
dangerous. The use of the WCW and WCL commands should normally be limited to use within
QuickControl. QuickControl checks for errors by keeping track of which line in the buffer will be modified
and by querying for the parameter to be changed, rather than blindly changing data.

Both the WCW and the WCL commands work the same way. The difference between them is that the
WCW command is used for 16-bit parameters and the WCL command is used for 32-bit numbers. When
either of the commands is issued in a program, the device replaces part of the data in the Program
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Buffer with the data in the register the WCW or WCL command specifies. With QuickControl, the
Program Buffer data to be replaced is specified symbolically, rather than with an actual memory
location, reducing the chance for error. The QuickControl screenshot shows the WCL dialog box used
with QuickControl. The parameters for both commands are the same. QuickControl requires the register
containing the value that will overwrite the old data, the label of the line containing the command that
will be modified, and the command parameter that will actually be modified.

The WCW and WCL commands can turn any command into a register-based command. A simple
command to do this with is the Velocity Mode, Program Type (VMP) command. The VMP command
requires two parameters: velocity and acceleration. Normally, these parameters are entered with the
VMP command and are fixed until a second VMP command is issued. However, if multi-tasking is
enabled and a WCL is issued in the program, this can change. One WCL command can link the value in
one 32-bit register to either the velocity or the acceleration parameter of the VMP command. This
means that two WCL commands could link the values in two user registers (registers 30 and 31, for
example) to the VMP parameters. Every time the VMP command is issued, it will use the values copied
from the user register specified by the WCL commands. Data in the user registers can be changed by a
program, by an external host, or by an analog input.

i Calculation Example
@ﬁj This exercise demonstrates the use of several different functions of the Calculation (CLC)
command. It begins with a long move, calculates half the distance moved, and moves back that
amount. It is strictly a demonstration of the CLC command. The SilverSterling and SilverDust also have
the Calculation Extended (CLX) and Calculation with Data (CLD) commands which allow three parameter
calculations and additional operations. These may make calculations easier to write and to understand.

1. Power up the device and start QuickControl. Start polling the motor and verify that the system is operating
properly.

2. In QuickControl, select File > Open. Navigate to “...\QCI Examples\Data Register\” and select the file, Register
Moves by half with Calculation.qcp.

3. Select Tools > Register Watch to open the Register Watch tool. Press the Add Register button and select User
(25). Select Position for the Data Format and press OK. Repeat for Accumulator (10), Actual Position (1), and
User (30). Choose Position format for each register.

The value in register 25 is how small the move position will be allowed to become before restarting.
Raising this will make the cycle time shorter. Register 30 contains the beginning position for the
move. The accumulator is used with most of the CLC operations in a similar manner to how the
accumulator is used in an assembly program. In this exercise, the accumulator’s value is not used
directly by the motion command. The value in the actual position register should be User[30] —
User[25] at the end of each move.

4. Press the “Download/Restart” button to download and run the program. The motor will begin its first move of
30,000 counts.

5. The calculation process is reasonably simple, using a few math operations to accomplish its task. Any
data in the accumulator is first cleared, and then the actual position is subtracted from the
accumulator. This results in a negative position value. After this, the binary value in the accumulator
is bit-shifted right, which is the binary equivalent of dividing by two. This value is placed in the register
used by the move. After this, the absolute value of the accumulator subtracted from the value in
register 25. If the result of this calculation is negative, the new move distance will be less than the
value in register 25, and the program will reset the position to 30,000 counts.

NOTE: Single Step or Trace through the program to see how each CLC command effects the
registers in Register Watch.

NOTE: Using the commands CLX and CLD simplifies this example and should be used on SilverDust
and SilverSterling servos.
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i1 Dynamic Speed and Acceleration Adjust - Modifying "Fixed" Parameters
g?j This exercise uses “multi-tasking “ with Write Command Buffer Longword (WCL) commands to
dynamically adjust the velocity and acceleration parameters of a Velocity Mode, Program (VMP)
command. The parameter data is loaded into two registers directly by the user. This program consists
primarily of a loop that contains two WCL commands and a VMP command. The WCL commands move
data from register 25 and register 26 into the velocity and acceleration parameters of the VMP command,
respectively. Using the Register watch tool, both parameters of the VMP command can be modified.

In a real world application, a host could issue Write Register, Inmediate Type (WRI) commands via serial
communications to change the parameter values. Additionally, the Calculation (CLC) command can be
used to modify the register data. XRV is a register based version of VMP that directly uses registers
rather than using the WCW or WCL commands.

1. Within QuickControl, select File > Open and navigate to ‘...\QCl Examples\Applications\” and select the file
‘Dynamic speed & accel in VMP.qcp’

2. Pressthe “Download/Restart” button to download and execute the program. The motor will NOT start
moving, since the default Velocity is O rps and the default Acceleration is O rps/s.

3. Open the Register Watch Tool (Tools > Register Watch). Press the “Add Register” button and select User (25),
select Velocity for the Data Format and press OK. Repeat again for User (26) except select Acceleration for the
Data Format. Both should have 0 values listed.

4. Click once in the data column of the User (25) entry. Enter a value of 5 rps for the velocity (be aware of the
scaling being used) and press enter. Select the data field of User (26) and enter a value of 2 rps/s into the cell.
Note: If no “units” are shown in the right column, double click on the units field of the Register Watch Tool
and choose the appropriate type (Target Velocity (32 bit) for Reg. 25, rps & Acceleration for Reg. 26, rps/s).

5. Experiment with other values in these registers and note the effect on the motor operation. Try starting with a
very slow Acceleration rate (0.5 rps) and a Velocity rate of 30 rps. After motion begins, increase the Velocity
rate to 1 rps, then 5 rps, and then 10 rps... Notice the dynamic Acceleration change.

Input Mode Commands

Three commands, Position Input Mode (PIM), Velocity Input Mode (VIM), and Torque Input Mode (TIM),
are used to access three special operating modes. The Input Modes use seven data registers for
processing position, velocity, and torque information. They allow the servo to use data from an analog
input or an external host to directly control motion. For example, this a good way to configure the servo
to respond to a joystick or analog input. These powerful commands are beyond the scope of this
document. See Application Note " QCI-AN047 Input Mode - Joystick".

Shutdown and Recovery

Every servo cycle (120 microseconds), the SilverLode servo performs an error check based on the
settings issued in the Kill Motor Conditions (KMC) (SilverDust Rev 06 or KMX command). If any of these
kill conditions are met, the program specified by the Kill Motor Recovery (KMR) command is
immediately loaded. The program specified by KMR can then perform any operation, a shutdown,
recovery, or other technique. For details on this advanced topic, see Technical Document QCI-TD052
Shutdown and Recovery on our website.

Advanced Topics

Please refer to the technical documents available on our website for further instruction and
information on advanced topics, such as camming, torque control or interpolated motion control.
Our Technical Support Staff are also available by phone or email during regular business hours.
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Chapter 4: Input Output Functions

SMI and SIP interfaces

The SilverNugget servos have I/0 voltages level from 0 to +5 Volts for both digital and analog operations.
The SilverDust and SilverSterling servos have 1/0 voltages level from 0 to +3.3 Volts for both digital and
analog operation, but are 5v tolerant. All digital I/0 used as inputs are digitally filtered, with default
filtering time typically set to 10ms in the initialization file. This filter time may be changed, as a group or
individually, from 120usS to over 5 seconds.

The SilverNugget and SilverDust controllers provide an SMI input. This 15 pin high-density D-sub
connector includes power supply, communications, a 5v/100mA output, and seven Input/Output (1/0)
connections, four of which also support analog inputs. Encoder quadrature or step-and-direction inputs
may also be applied to these inputs.

The SilverSterling provides an SIP input. This 15 pin high-density D-sub connector includes power
supply, communications, a 5v/100mA output, and four Input/Output (I/0) connections, one of which
also supports analog input. Three of the connections are dedicated to CAN.

The SilverDust IGB has the SMI interface plus sixteen additional expanded 10 lines (10101-10116). These
expanded 10 are optically isolated from the rest of the controller, and must be powered from 12v to
24v. The expanded outputs are NPN - that is, they are open collector outputs with a feedback
comparator set to approximately 1.5v. An internal pull-up resistor is tied to the isolated 5v supply
(derived from the isolated 24v supply). The input thresholds make these inputs compatible with 3.3
through 24v logic, while the outputs are rated to 250mA each, and include clamping to handle inductive
loads.

The SilverDust 1G8 has 8 expanded IO lines (10101.-108). These 10 function the same as those in the IGB,
except that no external 24v supply is needed. The I1G8 also has three additional lines, 201, 202, and 203.
Setting 201 lights the user status LED, while clearing it turns it off. 10 202 and 203 are attached to the
optional Ethernet converter’s User 10 2 and 3, respectively. These 10 may be configured as inputs to
monitor the Ethernet 10 or as outputs to drive the Ethernet 10. |0 201-203 do not include I/O filtering
functions, as these inputs internal should be noise free.

The SilverDust IG8 also has an optional special Encoder/SSI port. This port may be used to input or
output differential encoder signals, as well as being used to interface to Synchronous Serial Interface
encoders. Additional signals have been provided to allow interface to SPI style devices for future
expansion. This port is configured via the Synchronous Serial Interface (SSI) command. Differential
Encoder Input also requires the Select External Encoder (SEE) command.

I/0 Functions

The seven I/0 lines can be used for many different functions. The table below lists the I/0 functions,
their type, their description, and the 1/0 lines they use. I/O 101+ are only available on the SilverDust-IGB
and 1G8. 105-7 are not available on the SIP connector, but are available from the internal 60 pin
mezzanine connector.
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Function Type Description 1/0 Lines
All'1/0 lines can be used as general-purpose digital inputs or
General Digital Input Digital Input general purpose outputs. The inputs can be used for a 1-7
and outputs number of uses within a program, including loading new 101-116.
programs and controlling program flow.
. . All 1/0 lines can be used as input stop conditions for motion |[1-7
Motion Control Digital Input commands. 101-116
Three I/0 lines can be used as Kill Motor Conditions, allowing | 1 -3
. . for immediate shutdown based on input. Any 10 can be used | SDO5:
Kill Motor Digital Input for SilverDust and SilverSterling via the Kill Motor Extended | 1-7,
command (KMX) 101-116
SilverNugget ONLY: I/O #1 can be used as a special digital 1
Modulo Trigger Digital Input | input to trigger, enable, or disable the modulo output
function.
SilverNugget and SilverDust :Four I/O lines can receive 4-7
General Analog Input | Analog Input | analog signals. These signals can be used within programs.
SilverSterling: 104 can receive analog signals 4
SilverNugget, SilverDust IG8: Three 1/0 lines can send the
Internal Encoder High-Speed | raw signal from the internal encoder as an output.(Note: 1-3
Output Output SilverDust-IG/IGB have dedicated lines, SilverSterling has
these signals on the 60 pin mezzanine.)
. SilverDust IG8: 10 4,5 and 6 may be driven from either the
Inter/External High Speed | . ) ) .
Encoder Buffer Output |nter.na| or e>.<ternal encoder signals. This function is 4-6
configured via the SEE, SSI and EMN commands. .
. SilverNugget:Two 1/0 lines can send a scaled signal from the
High-Speed | . .
Modulo Output internal encoder as an output while I/O #1 can toggle the 1,6-7
Output .
function on and off.
SilverNugget and SilverDust: Three /0O lines can receive a
position signal from an external encoder (or another
External Encoder High-Speed | feedback device like a resolver). This signal can be used for |2, 3,
Input Input either dual loop closed loop or for an input position 4 — 6**
command for special applications including camming and
electronic gearing.
SilverDust, SilverSterling: allows 1/0 #2 to function as a
PWM output Digital 25kHz F_’WM ogtput, registered controlled, Wi_th the )
Output PWM width adjusted every 120uS as a function of
register values.
I/0 #1 can be configured as a “Done” output, indicating that
Digital the error is within the configured limit and the sequence has
Done output . 1
Output completed. See Enable Done High (EDH) and Enable Done
Low (EDL) for more details.
Digital I/O #1 can be configured as a Position Compare output,
Position Compare Output updated every 120 uS. This may be configured for a single 1

compare or for cyclic operation. See Position Compare (PCP).
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Curent Sinking and Sourcing capability

Sink or Source Limits

SilverNuggest SilverDust SilverSterling
Output 1 5mA 4 mA 2 mA
Output 2 5mA 2 mA 2 mA
Output 3 5mA 2 mA 2 mA
Output 4 5mA 4 mA 2 mA
Output 5 5 mA 4 mA 2 mA (internal)
Output 6 5 mA 8 mA 2 mA (internal)
Output 7 5 mA 4 mA 2 mA (internal)

Analog Inputs

I/0 lines 4, 5, 6, and 7 (SilverSterling: 104 4) can be used as analog inputs. These lines have an effective
internal impedance of approximately 200 kQ connected to the internal +3.3 (SilverNugget 5v) VDC
power supply, giving a slight bias on input. This resistance should be considered in circuit designs that
are passive or that have high impedance. 1/0 lines used as analog inputs must be driven from a low
impedance source (10 Q or less for SilverNugget and 1KQ or less for SilverDust and SilverSterling) or
with capacitance across the input. A minimum 0.01 uF capacitor can be used at the input to provide the
low impedance source. The internal analog to digital converter (ADC) provides 10-bit resolution (Silver
Sterling has 12-bit resolution) of the input signal.

The SilverLode servo implements a 5 msec filter on all analog channels to reduce the effects of noise &
transients. This means that analog signals are averaged over 5 msec before being used. The filtered
signal is updated every servo cycle (120 usec). (Note: some commands modify the filter constants.)

Using Digital Inputs

Digital inputs and digital outputs are the most basic uses for the I/O. A digital input could be a switch
that closes and opens, sending a signal to the servo, while a digital output might be a solid-state relay or
a light connected to a I/0 line. Digital inputs and outputs are used by the servo for several purposes.
Digital inputs may be used for program flow purposes, for motion control (stop on input) purposes, or
for Kill Motor triggers. Digital outputs may be used in user programs for signaling external devices like
PLCs or controlling external devices like relays. This section covers the uses of digital inputs and outputs
and the commands used with them.

General Digital Inputs

Four uses of the digital inputs are: general digital inputs, motion control inputs, modulo trigger input,
and Kill Motor inputs. By using an 1/O line as a digital input, a program can react to an on/off signal from
an external source by using a command that controls program flow based on I/O status. There are
several commands a program can use to do this. The “wait on bit” commands (WBS and WBE) can stop
program execution until a digital input signal changes, while “jump” commands (JOI, JOR, etc.) allow a
program to jump to another command within the program based on one or more inputs.

For example, if an application required the servo to start a move if a switch were thrown, the Wait on
Bit State (WBS) command could be used. This command can be tied to any I/O line configured as an
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input and can be set to wait until the input goes high or goes low. If the command were set to wait until
I/0 #1 went high, for example, the program would pause at the WBS command for as long as I/0 #1
stayed low. Assoon as I/O #1 went high, the program would continue. If a motion command
immediately followed the WBS command, then the start of the move would be tied to the state of I/O
#1.

A looping structure with a jump command could be used for the same application if multitasking were
enabled. A loop could be set up using the Jump (JMP) command to repeat the loop and a Jump On Input
(JOl) command could be inserted into the loop and tied to the state of I/O #1. If I/O #1 were low, the
loop would continue running repeatedly. When 1/0 #1 went high, the JOI command would cause the
program to jump out of the loop. If the JOI command pointed to a motion command, the start of the
move would be tied to the state of 1/0O #1, just like in the previous example. The example programs that
come with QuickControl illustrate both of these program flow techniques.

Kill Motor on Input

Digital inputs using 1/0 lines 1, 2, or 3 can be used as Kill Motor Conditions to immediately stop the
motor and end any move. Kill Motor Conditions are covered in detail in Technical Document QCI-TD052
Shutdown And Recovery on our website. As with other digital inputs, the Kill Motor routine can be set
up to trigger based on a high or a low state of an 1/0 line. If an 1/0 line is to be used as a Kill Motor
input, extreme care must be taken to ensure that the I/0 line is not used for another function. If an 1/O
conflict occurred on that line, the Kill Motor routine might not start when it was intended to. Kill Motor
Extended (SilverDust, SilverSterling) allow the use of additional 10 and conditions to trigger a Kill Motor
Recovery.

Digital Input Filter (DIF) Command

The DIF command sets up a filter time for any of the I/O lines used as a digital input. The filter time
affects how long a digital input state must be held for the SilverLode servo to see the given state. This
filter is useful for noisy systems or for de-bouncing switches because it causes the servo to wait for the
specified number of servo cycles (120 usec) before recognizing a change in the state of the input.

Using Digital Outputs

The digital outputs are used as signaling or control outputs. They can be used to indicate the internal
status of the servo to an external device like a PLC, or used to control another device like a relay or
another the device. The main commands used for this function are Configure 1/0 (CIO/ClI), Set Output
Bit (SOB), and Clear Output Bit (COB).

For example, a program could include branching logic that would jump to one of two sections of code
based on an input. One section of code would start a rapid move while the other section of code would
start a slower move. The section of code for the rapid move could also set I/O #2 high. That output
could connect to an input on a PLC. The section of code for the slow move could set I/0 #3 high and
that output could trigger another input to the PLC. With this setup, the PLC could monitor a critical state
of the servo.

With a similar setup, a SilverLode servo with the two move speeds could use its two digital outputs to
interface with two digital inputs on a second servo. The second servo could be programmed to respond
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in one way if the first servo were moving at the fast speed and in another way if the first servo were
moving at the slow speed. Interlocked programs like this can be very useful on multi-axis machines.

Using Analog Inputs

Analog inputs are another way to use the I/0O lines. An analog input could be a potentiometer, a Hall-
effect joystick, a temperature sensor, or a pressure transducer. A +5V power supply is available from
one of the pins that can provide up to 100 mA for sensors and other peripherals. The analog inputs can
be used for traditional PLC tasks like event triggering or data monitoring, or they can be used for direct
motion control (i.e. Joystick Control).

This topic is beyond the scope of this document. See Application Notes “QCI-AN023 Analog Inputs” and
“QCI-AN047 InputModeloystick” for more information.

Using Encoder Signals with Digital I/O

In addition to the other functions covered in this chapter, the I/O lines can be used for high-speed 1/0
functions. This section describes the types of signals used by the high-speed 1/0 functions, their use,
and commands used to configure them.

The external encoder inputs, either Quadrature or Step and Direction, are decoded to drive a hartdware
counter which is sampled every 120usec.

Encoder Signal Types
SilverNugget adn SilverDust: The high-speed digital /O functions use several types of signal formats:
step and direction, A and B quadrature, and, for the SilverNugget, step up/step down.

Step and Direction Signals

A step and direction signal consists of two parts: a step signal and a direction signal. As the figure
shows, every rising edge of the step signal equals one count. The direction signal is high for one
direction, and low for the other.
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54



Step Up/Step Down Signals

. S a8 e S
(SilverNugget Only) £ £ : 55
A step up/step down function o o o 8io
consists of two step signals. One —| —I —|

step signal corresponds to one

Step Up
count of motion in one direction,

while the other step signal
corresponds to one count in the Step Down ﬂ H ﬂ

other direction.

Step Up/Step Down

A and B Quadrature Signals
The A and B quadrature format consists of two step-like signals that are 90° out of phase with each

other. Every rising or falling edge of each signal corresponds to a count. Direction is determined by
which phase is leading and which is lagging.

Count 1
Count4
Count 7
Direction
Change

Phase A

Phase B — —L

A & B Quadrature

The preferred encoder input and output signal is A/B quadrature. The alternative formats of step-
up/step-down and step and direction transmit one pulse per encoder count and become subject to the
bandwidth limit more rapidly. For example: during a 1000 count per second move, the step formats
require 1000 pulses per second on a single line. A/B quadrature uses two signals, and therefore requires
only 250 pulses per second on each line to transmit the same information. A/B quadrature signals have
a lower frequency than the other two types of encoder signals. This is an advantage when operating in
electrically noisy environments. AB quadrature signals also are more resistant to noise, as a noise pulse
that is short enough is filtered, and one that is longer usually looks like a one count forward, one count
back, causing its effect to be non-cumulative. With the Step/direction inputs, sufficient noise on the step
line just causes the counter to continue to count.

See Application Note "QCI-AN019 Electronic Gearing" for more details.
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Dual Loop Control

In addition to simple encoder following control, the external(secondary) encoder input function can be
used in a position feedback configuration. This Dual Loop Control operation uses the external
(secondary) encoder signal count to replace the position portion of the internal (primary) encoder
feedback in the PVIA control algorithm. The internal encoder position signal is still used for motor
commutation, velocity estimation, and acceleration estimation. The SilverLode servo positions itself
according to the external encoder. This feature is very useful for two applications: high-resolution
feedback applications and applications requiring feedback directly from a machine or machine part
rather than from the motor shaft. The input signal from the external feedback device can be in any of
the three signal formats discussed in this section: step and direction, step up/step down (SilverNugget
only), or A and B quadrature. Note that the default tuning gains will need adjusting for different encoder
resolutions.

The Select External Encoder (SEE), the Dual Loop Control (DLC), and the Single Loop Control (SLC)
commands are used for this feature. The SEE command is used to configure the servo to receive the
external encoder input signal, just like when the signal is used for direct motion control. The DLC
command configures the servo to use the external encoder signal for position feedback in the PVIA
control algorithm. The SLC command puts the servo back in its default state of using the internal
encoder for all control purposes. Command details are available in the Command Reference.

There are two applications where dual loop control using an external encoder is very useful:

The Dual-Loop function may also use SSI style encoders on SilverDust IG8 units. This allows dual loop
control with absolute position feedback style encoders. The DLC command will use the SSI feedback if
the SSI port has been configured as the Dual Loop source via the SSI command prior to the DLC
command. Note that this frees up the step and direction controls to allow step and direction control of
the units while operating in dual loop mode.
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Chapter 5: Troubleshooting Guide

Troubleshooting Communications

With the SilverLode product powered up, start QuickControl and the polling routine should
automatically find the device. If QuickControl is already running and the device is powered up, press the
“Scan Network” button to find the device on the network. If “No Devices Found” appears in the Device
Status Monitor, either the device has been initialized with something other than the Factory Defaults
(listed in the Hardware Requirements section of this chapter) or QuickControl is not set up to
communicate with the device in its present communications state. Some things to check if this happens
are:

* Verify the COM port being used to connect to the device.

* Under Setup, select Comm Port / Comm Channels and ensure the baud rate and protocol are set
to Factory Defaults (57600 and 8 bit ASCII respectively). Also, confirm the Enable checkbox is
checked and the COM Channel enabled is the one device is connected to.

* Verify there are no other programs using the port (only one program can control a COM Port at
any given time). These can include other motion control drivers or programs used for
communication devices (e.g. Palm Pilot, HyperTerminal etc.). If these programs do not relinquish
control of the port, QuickControl will report “Could Not Open select COM Port” and “Access is
denied.” errors in the Status Log. Under Setup, select Register Devices and ensure all six devices
have the Auto Reg checkbox checked.

*  Run Tools = Unknown Device Wizard (only works with one device connected at a time)

* If networking multiple devices, QuickControl can only register six at a time for viewing.

* If networking multiple devices, each has to be initialized with the Initialization Wizard with a
unique ID.

* Under Setup, select Options and make sure the Autoscan ID range encompasses the ID of the
units desired.

* Reduce Baud Rate. If you are occasionally loosing communications with the device, try reducing
the baud rate. Remember to change both the PCs baud rate (Setup->Comm Port) and the
device's (Init Wizard->Communications->Baud Rate).

After verifying the integrity of the COM Port and making any necessary changes, try a quick
communication test. Stop the QuickControl polling routine (if it is running), and press the red hand icon
(STOP) button on the QC toolbar. The red LED on the back of device should flash briefly as it receives
and processes the Halt command sent to it each time the STOP button is pushed. This simple test can be
done at any time to verify that the device is receiving commands.

Itis also good to verify that the Windows PC can communicate through the serial port without
QuickControl. Programs like HyperTerminal can accomplish this (see Technical Document QCI-TD024 8
Bit ASCII Protocol Using HyperTerminal). If communication is successful with the third party terminal
program, then QuickControl should be able to operate correctly.

SilverLode Indicator LEDs

There are two indicator light emitting diodes (LEDs) on the back of every SilverLode product, one red
and one green. These LEDs provide the user some basic information about the current operational state.
When the device is first powered up the green LED should be on (on the SilverNugget, the red LED
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flashes on momentarily at power up as well). The red LED is the communication/program done
indicator.

If the red LED is on solid (dim glow), then no program is running and the device is not communicating.
When the device receives the start of a transmission, the red LED will shine extra bright. When the
transmission is processed, the red LED will return to its original state. Sending the device a number of
commands in succession (e.g. the QuickControl polling routine) will induce a flickering of the red LED.
This flickering can occur in regular intervals or as random blinks depending on the communication
scheme.

If the red LED is out completely, then a program is running from an internal program in the Program
Buffer (and, in the absence of flashes, no communications is taking place).

The green LED is normally used to indicate motor torque, it starts out a middle brightness, glows
brighter for positive torque and darker for negative torque. Its function changes if the Enable Done Low
or Enable Done High command has been set; in this state, bright indicates that the motion is complete
and the error is within set limits, while off indicates that the above are not true. The green LED is also
used to flash error codes in the case of power low, over temperature, etc. according to the user and/or
initialization program loaded. This is done by disabling the driver, setting open loop mode, and then
setting the “torque” high and low (though with the motor drive disabled, only the LED is affected).

Green LED Flash Code

Number of Fault

Flashes

1 Startup Recovery Program
Kill Motor Condition occurred at startup.

2 Kill Motor Recovery Program
Kill Motor Condition occurred after startup as a result of a condition in the
KMC or KMX command.

3 Initialization Wizard needs to be run.

4 I-Grade Motor Memory Read Error

5 I-Grade Motor Memory Version is Not Compatible

6 I-Grade Motor Miss-Match. Attached motor does not match with device. Re-
run Initialization Wizard

7 I-Grade Motor Memory Checksum Fault

The SilverDust IG and IGB also have a third yellow LED. This yellow LED lights to indicate that the
encoder signals are not at valid levels indicating shorts, opens, or otherwise invalid levels. A bit in the
Internal Status 2 (1S2) word indicates this state, and may be used to trigger a kill motor via the KMX
command. (See 1S2 and KMX).
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Troubleshooting Frequently Asked Questions

e Whydo I get a Driver Enable Error/Temperature Fault when | start up?

Most of our controllers require a jumper between CLAMP+ and DRV ENA. This is done differently on
each of our controllers.

IG: Jump pins 17 and 19 on the Auxiliary Connection.
IGB: This is found at the top of the controller.
IGC/IG8: Two jumper are needed. CLMP with ENA+ and ENA- with V-.
SilverNugget N3: Break out the SMI Port and jump pins 1 and 7.
e How do I know what my 3rd party hardware/software is sending to the controller?

QuickControl has a function called ‘Data Monitor’ which shows all of the transmitted and received data
in the controller. This can be accessed by clicking on Tools->Data Monitor.

e How can I check the value of my registers while the program is running?

Click on the Tools tab in the toolbar and scroll down to Register Watch. This will open a dialog box that
will allow you to see any register by clicking on the button Add Register. Another dialog box will appear
with the list of all registers on the current device. Select the appropriate data format.

e How can I see all Internal Status registers and the data it currently contains?

QuickControl has a function called ‘Diagnostics’ which shows all of the registers contained within the
controller and their corresponding data. This can be accessed by clicking on Tools->Diagnostics.

Common Issues

Controller

Controller doesn’t

power up No power to the Check the following are securely fastened:
No liaht controller (+12V to
(No lights) +48V) e SMI cable & breakout boards

Ensure that the Processor switch is turned on, if equipped.
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Verify that 12 to 48 volts is applied to Input Power and
Power Ground
e SilverLode Multi-Function Interface (SMI)
V (+):Pinslor7
V(-):Pins6orll
e SilverNugget N3
o Apply 12 to 48 volts to Pin 1 (SMI) to
enable the driver
o Apply 12 to 48 volts to Pin 7 (SMI) to power
the processor
o Apply 12 to 48 volts to the DB3 connector
to power the driver
o Ensure the clamp module’s Power LED is
on

Unit was hot-plugged

Contact QCI Support.

Controller doesn’t
communicate with
PC, HMI, PLC, etc.

(Power and/or
Status LEDs flash)

Communication wiring
is incorrect

Verify that serial cable is a straight through cable (pin to
pin) and NOT a crossover cable nor a null modem cable.
e Pin2-> Rx
e Pin3->Tx
e Pin5 - Logic Ground

Try swap communications lines:
e Rx-->TXx
e Tx-->Rx
e A->B
° B->A

RS485 signals are reversed between SilverNugget and
SilverDust.

Remove RS485 termination if communicating in RS-232.
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Incorrect COMM port
selected in
QuickControl

Go to Setup—> COMM Port to modify COMM. port number.

Unknown Device
Wizard succeeds but
Initialization Wizard
does not. “Download
Fail”

More than one unit is connected to the communication
network. Isolate the controller.

QuickControl doesn’t have the current motor’s parameters.
Update devAux.txt file or update QuickControl version.

Upgrade QuickControl to latest version.

Unknown Device
Wizard = No Devices
Found

Verify that only one unit is connected to the PC.

Verify that no other devices (HMI, PLC, etc) are connected
to the communication lines.

SilverNugget does NOT support Polling/Debugging with
QuickControl setup for [J[{e]s]s85:.

e Change COM port to 8-hit ASCII to communicate
with controller 2 Unknown Device Wiz
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Communications
parameters don'’t
match

Set COMM Port in QuickControl to the following defaults:

8-Bit ASCII, 2 Stop bits/ No Parity

Run the Unknown Device Wizard, Verify COMM light
flashes.

Run the Initialization Wizard and verify communication
parameters between PC and controller match.

COMM port number
out of range

QuickControl 5.xx and back, onl
COMM ports (1 2> 9),

Refer to Windows documentation to change COMM port
number.

COMM port is blown
— Most likely unit was
hot-plugged.

Measure impedance between Tx and Logic GND & Rx and
Logic GND

Both should be within the range of 23KQ & 26KQ

RS-485 under
powered

Increase voltage to the RS-485 module, QCI-RS485. Up to
50V max.
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Un-configured, bad or
blown COMM port

Restart computer.

If available, try a different COMM port and/or computer.

If using a USB-t0-RS232/RS485, verify the latest
manufacture’s drivers are properly configured.

Power supply
intermittent

Power supply set for 220VAC

Change to 110VAC

Controller not responding as
expected.

No Device Found

“DIF” command not
valid

Driver not enabled.

Early firmware revisions don’t support newer commands.

Downgrade to QuickControl 4.2 and delete any commands
not supported.

Device busy or not
responding

Product line
mismatch.

QuickControl version doesn’t support device.

Download appropriate version.

Controller starts up with “Driver
Disabled”

Underrated power
supply.

Connect a higher rated power supply.
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QuickControl Software
Issue

Motor doesn’t move to
commanded position or
at commanded
Velocity/Acceleration

Cause

Motion parameters are
initialized with wrong data
format.

Motion parameters request
for a slow motion.

Action

Double-click register write commands ((WRP) and
select proper data format.

If communicating from a Host, verify that the
transmitted data is in SilverLode units.

Verify units in Register Watch

Tools - Diagnostics - 10S tab - Bit #3:Trajectory
Generator

e If Bit #3 is ACTIVE(1), the motor is
processing a motion.

“Prog Stop” & “NO
COMM” rapidly flashes
under the device status
monitor.

QuickControl is attempting
to access a register read
from an invalid location.

In the Register Watch window remove any invalid
registers.

SilverMax/SilverNugget valid registers
e 0 through 40
e 200 through 233
SilverDust/SilverSterling valid registers
e 0 through 255
e 64000 64016
SilverSterling valid registers

e 0 through 255
e 64000 through 64016
e 50000 through 50511

QuickControl cannot
open COM port

Windows 7 compatibility
issue

Configure QuickControl to run as Windows XP in
compabibility mode

Go to QuickControl root directory (C:Program
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Files/QuickControl).

Right-click on the QuickControl application. Click on
the Compatibility tab. Check “Run this program in
compatibility mode for” checkbox and select
“Windows XP Service Pack 3”.

Motor
Issue

Motor doesn’t
rotate

(No holding
torque present)

Cause

Motor is
disconnected.

Action

Check the motor cable is securely fastened.

Bad/damaged motor
cable (s)

Swap motor cables.

Controller is not
initialized via the
Initialization Wizard
or is initialize with for
a different motor.

Run the Initialization Wizard.

Refer to the Green Status LED Flash Code

Erratic behavior
(Holding torque
present)

Motor Oscillates

May require tuning.

Default tuning parameters are good for 10:1 inertial mismatch.

Motor faults/kills at
the start of a move

e Motor underrated. Not enough torque to complete move.
Acceleration parameter too high
Power supply underrated. Verify power supply can
provide enough power to the motor(s).

Index phase is not
aligned

On an N3 controller run the Initialization Wizard - Click Options >
Check Index Phase Alignment
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Damaged encoder
Open-Loop Test

Open the Initialization Wizard. Click the Open button and select the
“Factory Default Initialization - Open Loop.qcp”. If necessary,

correct the motor cable length and click Download File to Device.

e The controller will ignore the encoder and all
accumulated position error counts. Open the Contro/
Panel and begin to jog the motor. If the motor spins,
there’s an issue with the encoder:

1. A pushed-in shaft can damage the encoder

2. Hot-plugging can damage the encoder and/or
encoder flex.

Loose coupling
Check couplers are tightly secured.

Bad driver
Blown driver(s)
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Appendix |: Sample Programs

Sample Programs

QuickControl comes preprogrammed with many sample programs, located in the QCl Examples Folder.
Custom programs can be made by stringing together existing programs. For example, the Initialization
program file contains the following programs:

Main Init
The Main Initialization program contains all of the initialization commands for the device. This program
is shown in the next section and is described in detail.

Startup Recovery

The Startup Recovery is used if a Kill Motor Condition is tripped during execution of the factory default
initialization. The default program, disables the driver and flashes the green LED once. See SilverLode
Indicator LEDs later in this chapter for flash definitions.

Kill Motor Recovery

This program is called whenever a condition set in the Kill Motor Conditions (KMC) command is tripped.
This may be modified if special processing is required. The default program, disables the driver and
flashes the green LED twice. See SilverLode Indicator LEDs later in this chapter for flash definitions.

Power Low Recovery

This program is called whenever voltage drops below the specified threshold in the Low Voltage Trip
(LVT) command and may be modified if special processing is required on a Power Low condition. The
default program, disables the driver and ends the program.

Flash Seq
A utility program that flashes the green LED the number of times specified in register 11. The program is
called by the error programs to flash the LED. See SilverLode Indicator LEDs later in this chapter for flash
definitions.

Factory Block Fault

This program is run when a fault has occurred in the Factory Block (see Memory Model for details on
Factory Block). This program simply adjusts to flash sequence to correspond with the other faults and
runs the Flash Seq program. See SilverLode Indicator LEDs later in this chapter for flash definitions.
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Appendix Il Initialization and Set Up

Initialization File

It is good practice to save a record of the specific power up changes made to each device as a unique

Initialization file. This file should contain all the command settings for any particular device in a specific

application. The initialization file also contains application parameters such as the Identity, Serial

Interface, Baud Rate, Kill Motor Conditions, Error Limits, etc. There should be one initialization file per

axis on any multi-axis machine.

When using the Initialization Wizard for the first time, the Factory Default Initialization.qcp file is

automatically opened in the Wizard File window. This is a read only file and cannot be overwritten. To

save any changes made to the initialization file, press the Save As button and give your file a unique

name. In future Initializations, you can then Open and select your specialized Initialization file instead of

the Factory Default.

Initialization Wizard Details

All SilverLode products must go through the Initialization
Wizard at least once before operation or anytime a new
type of motor/encoder is used.

NOTE: If the unit has previously been initialized, you
might want to start the Initialization Wizard with the
controller powered down to prevent any previously
downloaded programs from running. For an un-initialized
device (i.e. fresh from the factory), this is not necessary.

To run the wizard from Tools menu:
Tools -> Initialization Wizard

If your unit was powered up, you should see something

Initialization Wizard
Press "Download..." ta initislize serva or change the

factony default parameters using the "Initislize Parameter
Browser".

Initialization ‘izard | Turing ‘Wizard |

==

Device "UID=16" Optiong | Daownload File
b abar AZIHI To Device
DEYICE DETECTED: Unit ID =16 Matar Cable
SilverDust D2 1G, sn=4543 Length
|-Grade Mator: A23H3, CPR=8000, sn=3122 ,4_ t

|Fact0r_l,l Default Initialization. gcp

Initialize Parameter Browser

Open

- Communications
Save -- tdotor

-- Servo Tuning
Save s [l Motion

[ Enar Limits

B Misc

like the dialog box shown. If using an |-Grade SilverDust with an I-Grade motor, the motor type, encoder

type, and motor serial number will be displayed. Other combinations of motors and controllers will not

display this information. If the controller is not powered up, then controller and motor type will not be

displayed. Please see Appendix | for further information on specific Initialization scenarios.
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59 Basic Default Initialization

This exercise demonstrates how to accomplish a basic initialization of the device using the
Factory Default Initialization File.

1. Toinitialize the device using the wizard, begin by choosing “Initialization Wizard” under the
“Tools” pull down menu.

Initialization Wizard

2. Verify the filename “Factory Default -y
L . e 1 4 . Press "Download..."' to initialize servo or change the
Initialization.qcp” is listed in the File box. factory default parameters using the "Initialize Parameter

Browser",

Initialization Ywizard | Tuhing *izard |

Device "UID=16" Dptions | Daownload File
bed ok AZIH3 To Device
DEVICE DETECTED: Urit 1D =16 Mator Cable
SilverDiust D2 G, en=4549 Length

|-Grade Mator: A23H3, CPR=8000, sn=3122 /v|4_ t

A |Factor_l,l Default |ritialization. gep /
ﬂ Initialize Pa)mﬁamwge,

H 2Armmnunications
[+ Motor

: - Servo Tuning
- Motion

+]- Error Limits

7 Misc

Save

3. Verify Motor Cable Length is correct. /

4. Select the “Download File To Device® button to have the default initialization file downloaded to
the device.

5. The servo will automatically restart and the parameters will then become active on each
successive power up and motor restart cycle.

6. The Program Downloaded screen will appear when downloading is complete. Press the “OK*
button to clear the message screen.

7. To exit the Initialization Wizard, select the “Exit w/o Save® button on the screen.

8. If polling is stopped, press the “Scan Network” button to verify proper communications and
polling of the device.
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Initialization Scenarios

The following are typical initialization scenarios. Please note, the Initialization Wizard must be re-run

anytime the encoder is loosened, or a different motor/encoder pair is connected.

Scenario 1: I-Grade SilverDust Controller With I-Grade Motor
This is the most common and simplest case because the I-Grade SilverDust reads most of the

information it needs from I-Grade motor memory.

1) Press "Download File to Device".

The Initialization Wizard uploads motor ID and encoder information from the I-Grade motor memory

and initializes the motor.

2) Finish

A screen will appear indicating that the selected initialization qcp file has been downloaded. Select OK to
exit. The unit should now be initialized and ready for operation. (It may need to be restarted if the No
Restart on Download option was selected.) Press Exit to leave the Initialization wizard.

Scenario 2: I-Grade SilverDust With Non I-Grade Motor
1) Press "Download File to Device".

The Initialization Wizard fails to upload the motor data and
displays the "Error Reading Data From Motor Memory" dialog
box.

2) Error Reading Data From Motor Memory Dialog Box

The following choices are presented:

Error Reading Data Froem Motor Memory

Mo motor detected.
Chooge from one of the following options:

1 Contmue Continue:  The attached mator
has no memany.

2 Continue; Cantinue: | will sttached & motor
b otar b emary with mernary.

3) M Cancel out of wizard

e Continue: No Motor Memory: Select for non-I-Grade motors.
e Continue: Motor Memory: Select if an I-Grade motor will be used, but is not currently attached

to the SilverDust.

e Cancel: Select Motor
n . . n
Press " Continue: No Motor Memory Select Motar
OC1 Grade 2303 (323L3) -

3) Select Motor Dialog Box

Select the desired motor and press Next.

(CH -Grade 24P-B [224FE]
[CH -Grade 34L-1 [434L7)
GCI M-Grade 11-1 [M111)
GCI M-Grade 17-1 [M171

QL M-Grade 17-3 [M173)
QLI M-Grade 17H-1 [M17H1)
[CI M-Grade 17H-3 [M17H3]
GCI M-Grade 23-3 [M233)
GCI M-Grade 23-5 [M235)
QCI M-Grade 23H-1 [M23H1]
QI M-Grade 23H-3 [M23H3)
QC1 M-Grade 23H-5 M23H5 >

m

Mext | Cancel
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4) Determine Encoder CPR (optional)

If you select a non I-Grade motor, you will get this
dialog box after you edit the Custom Motor dialog
box and Press OK. If you know your encoders

Counts Per Revolution (CPR), select it from one of

Determine Encoder CPR

Mo default encoder found, Encoder CFR
canh be determined by testing or by manually
entering a value

=
_ Coeel_|

Cancel

4000

=

the options. You can also select Test Encoder. Note selecting Test Encoder will require that the wizard

rotate the motor.

Press OK

If you selected Test Encoder you will a message warning you about the motor moving, otherwise the

wizard will finishes like Scenario 1 above.

Scenario 3: SilverNugget or SilverDust MG
1) Press "Download File to Device".

2) Select Motor Dialog Box ...

The rest is the same as Scenario 2 above.

Scenario 4: SilverDust with Custom Motor or 3rd Party Motor

QuickControl can initialize a SilverDust controller to servo most stepper motors as long as they are

within the current limitations of the driver (see controller datasheet). QuickControl needs the following

information:

1) Press "Download File to Device".

2) Error Reading Data From Motor Memory Dialog Box (I-Grade SilverDust Only)

Press "Continue: No Motor Memory"

3) Select Motor

Select "Custom Motor" for you controller.

Press Next
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Select Motor

Select Mator

GCI |-Grade 23L-3 [423L3) -
GC! |-Grade 24P-6 (424P%6)

GCI |-Grade 34L-1 [434L1)

GCI M-Grade 11-1 [M111]

GCI M-Grade 17-1 [M171
[C| M-Grade 17-3 [M173)
GCI M-Grade 17H-1 [M17HT]
GCI M-Grade 17H-3 (M17H3)
GCI M-Grade 23-3 [M233)
GCI M-Grade 23-5 [M235)
GCI M-Grade 23H-1 (M23H1]
GCI M-Grade 23H-3 [M23H3]
GCI M-Grade 23H-5 M23H51 b

Hext |

m

Cancel




4) Enter this information from the 3rd party motor's
datasheet.

Press OK.

NOTE: Only edit Advanced options with QuickSilver Tech
Support's guidance.

NOTE: This information is stored with MCT command in
the Initialization Program File (i.e. My Custom Init.qcp).

Edit Custormn Motor @

WARMNIMG: Incorrect parameters could result
i motor damage

Cancel
Iotor Description Custom Motor Advanced

Diriver Dz - Units

i
Diriver Voltage 48 | oy 4

% Englizh
Fiated Curment [per phase] |2 A

Inductance [per phase] 0.7 mH
Fesistance [per phase) |05 ok

Ratary l Linear ]

Fotary Step Motor:
2-phaze, 1.8° step, bipolar winding

Rated Holding Torque 27 i

[2 phazes energized)

Determine Encoder CPR @

5) Determine Encoder CPR (optional)

The rest is the same as Scenario 2 above.

Mo default encader found. Encader CPR
can be determined by testing or by manually

entering a value
g Cancel

4000

=

Scenario 5: I-Grade SilverDust Controller With I-Grade
Motor To Be Attached in the Field

Since all the pertinent motor and encoder information is
contained in the motor's non-volatile memory, it is possible to
initialize an I-Grade SilverDust without the I-Grade motor
attached. Simply run the Wizard without the motor attached.

1) Press "Download File to Device".
2) Error Reading Data From Motor Memory Dialog Box.
Select Option 2 "Continue: Motor Memory "
3) Select Motor Dialog Box
Select the desired motor and press Next.

3) Finish

Error Reading Data From Motor Memory

Mo motor detected.
Choose from one of the following options:

1 Contlnue Continue:  The attached mator
Ma Motar WMemary | has no memory.

7 Continue: Cantinue: | will attached & mator
batar bemary with memary.

3 M Cancel out of wizard

The wizard finishes as normal. Power down the controller, attach motor and power up. As long as the

selected motor matches the attached motor the controller will work fine.
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Initialization Wizard Options
Selecting the Options button will allow you to change the initialization options:

e Restart on Download (default checked): This option selects whether the device is to be
restarted automatically after each initialization file download. In order for any changes in the
initialization file to take affect, the device must be restarted.

The device can be manually restarted by pressing the Restart button on the Program Info
Toolbar or by cycling the device’s power. If you are changing the Identity, Baud Rate, Serial
Interface, or Protocol, delaying the restart until all user programs have been downloaded may
simplify the process.

e Maximum Velocity Scale (default 4000RPM): This option allows the user to select the default
4000 RPM or to change the velocity scaling in the system for lower top speeds. With a lower top
speed, the scaling for velocity parameters as well as the actual velocity registers is changed so
that a full scale value for each of these will correspond to the selected velocity. The velocity and
acceleration terms in the CTC and FLC commands may need alteration (to be lowered) in your
application if a value other than 4000RPM is selected. Velocity control for systems that do not
need higher velocities may be improved by selecting a lower Maximum Velocity.

e Advanced Line Resistance (default unchecked): This option causes an addition dialog box to
appear anytime a device is being initialized that allows for calculating resistance for user cables
using various wire gauges.

e Encoder Resolution Reduction (default Divide By 1): This option is only available for SilverDust
units. It is intended to allow programs written for older 4000 CPR (count per revolution) systems
to be easily adapted to the newer 8000/16000 CPR motors. A divide by 1 provides the full 8000
CPR resolution when using an 8000 CPR encoder. The divide by 2 option “downgrades” the
resolution, so the system behaves as if a 4000 CPR encoder is attached.

e Save On Exit (default checked): Check this button to save the file (to the PC not the attached
device) when the "Exit..." button is pressed. Note, the "Exit..." button's name with change to
"Exit w/ Save" when this box is checked.

e Erase Application Programs (default checked): When wizard is run, the user's application
programs stored in the controller are erased. This option can be unchecked as long as Index
Phase Alignment is not used. The wizard must erase the user program(s) in order to make room
for the Index Phase Alignment program run within the wizard.

e Choose Motor/Configure Encoder (default unchecked): If this option is checked, the user will
be prompted to select a motor every time the wizard is run. If this option is not checked, the
wizard will only prompt the user to select a motor if it thinks it needs to. Examples of this would
include:

o Un-Initialized Device (fresh from factory)
o Index Phase Alignment Option Changed

NOTE: If you want to re-initialize a controller for a different type of motor/encoder, check this
option at least once. This will force the wizard to prompt for you for a new motor type.

NOTE: This option is ignored when using the SilverDust |G or IGB with an |-Grade Motor, as the
motor type is automatically read from the non-volatile memory inside the I-Grade Motor. See
SilverDust IG/IGB With I-Grade Motor Memory Initialization for details.

e Index Phase Alignment (default checked):If this box is checked, the servo will use the encoder
index (z channel) signal to set its phase alignment at power up. If this box is not checked, the

servo will rely solely on the initialization program's phase alignment.

73



Unknown Device Wizard

The Unknown Device Wizard is helpful if a device is not automatically recognized by the QuickControl
software. When the Unknown Device Wizard is run, it prompts the user to cycle power to the device
while the wizard is sending out a continuous stream of HLT commands through the Comm port. At
power up, the controller listens using each protocol and serial interface while configured for 57600
baud. When the controller “hears” the halt in the given format, the controller will halt, otherwise the
normal startup routine will run. The wizard will then prompt for communication configuration of the
device. These settings should match how QuickControl is configured. Note that the protocol (8-Bit ASCII
or 9-Bit Binary) is determined by the settings under Comm Port in the Setup menu of QuickControl to
ensure that the protocol matches QuickControl. Please refer to Technical Document QCI-TDO53 Serial
Communications on our website for a complete discussion on differences between serial interfaces.
Upon completion of the wizard, the device will be successfully communicating.

NOTE: When using a SilverDust with the E-485 Bridge option (Ethernet), the wizard will take a minute or
so to complete.

Download File To Device
Press this button to start initializing your device.

Note if the unit was powered down previous to starting the initialization process, or if the Baud Rate,
Protocol, or Serial Interface do not match the connection to the PC, the Unknown Device Wizard is
automatically invoked to establish communications with the device.

Default Configuration

When shipped from the factory, the SilverLode product and QuickControl software are initialized with
default values that are used to establish initial communications between device and a PC. Remember,
these values can then be edited during the initialization procedure.

Unit ID 16
Supply Voltage 48VDC
Serial Communications Protocol 8 Bit ASCII
Serial Interface (R:-SZ-uZ;zzfor
SilverSterling)
Baud Rate 57600

For SilverDust controllers with the E-485 Bridge (Ethernet) option,

Unit ID 16
Supply Voltage 48VDC
Serial Communications Protocol 8 Bit ASCII
Serial Interface RS-485
Baud Rate 57600
IP Address DHCP
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Typical Configurations

The following describes typical configurations for SilverLode servo systems. This section is not an all-
encompassing list. There are many variations and additions that are possible. However, these examples
should provide a good starting point.

For detailed examples on using any particular controller/driver in a system, please refer SilverLode
Controller/Driver Datasheets on our website.

Standalone Configuration

SilverLode servos are capable of operating as a system-level controller without any input from a master
controller or user interface. To function in this manner, SilverLode servos are pre-programmed to
produce the desired motion and to respond to any sensors or other inputs in the system.

Often in this configuration, the digital 1/0 is used to initiate the required operations by programming the
product to start, end, or select programs using different I/0 combinations.

Host Configuration

Host configuration involves a SilverLode servo that is entirely controlled by a host PC, Programmable
Logic Controller (PLC), Human Machine Interface (HMI), or other such device. The host is connected to
the device through the RS-232/485 serial port or the E-485 Bridge (Ethernet).

Operation in host configuration mode has the SilverLode configured as a passive slave to the host
controller, waiting for each command before performing any operation. After the initialization routine
has completed, no additional internal program stays running that would allow the device to perform an
operation by itself. This allows for extended operations not available in a SilverLode only network. In
cases where many axes of control are required, a host configuration can achieve very complex or highly
coordinated multi-axis control. A host controller can also retrieve data from registers.

Hybrid Configuration

A hybrid configuration utilizes a SilverLode servo operating such that the servo receives command from
an external controller, executes internal programs, and uses its internal 1/O . This configuration is more
versatile than either a pure standalone or pure host-controlled configuration. The SilverLode product
can use its standalone abilities to execute internal programs and interact with the system through its I/O
and registers. Also, an external host can issue commands or interact with programs.

Multiple SilverLode Servo Configurations

A SilverLode product can be part of a small RS-232 or a larger RS-485 network. In addition, two or more
devices can be interconnected through their I/0O lines. The possible configurations for multiple device
systems are seemingly endless, although all of the configurations are just combinations of the two basic
configurations listed in this section. Many of the advanced applications for SilverLode products use this
capability. In CANopen™ operation, controllers may also interact with each other as peers.
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Setup Menu Details

Comm Port
From the main menu, select:

Setup -> Comm Port

If the Communications Device Properties shows the correct

communications port, check the Enable box and press OK.

Setup Communication Port
The Communcation Paort maybe modified by
puzhing the Madify Buttan,

Orce the desired device has been selected,
check "Enable".

Communication Device Properties

COM3, 8-Bit ASCIH, Baud=57600

(=]
_ taneel |
_ Modiy_ |

Madify

Cancel

Press Modify to edit the Comm Properties.

Register Devices

QuickControl will monitor the status of a device when the device is registered into the system and

polling is enabled. The polling function continually checks the status of any registered devices and
updates the Control Panel, Register Watch and the Device Status Monitor. Registration can be done

automatically (recommended) or manually.

Anytime Polling is started, QuickControl will automatically scan all for any devices within the selected

range ( default range is addresses 1-20). If a device is found, the device will be automatically registered

and will appear in the Device Status Monitor screen.

To manually register a device, select,
Setup->Register Devices

Press “Add Device” to manually register a device.

Note: Manually registering is best to use if you want
QuickControl to communicate with a non-QCI motor.

Unit ID (UID) ==
Edit Uit 10 [1-254]
Cancel
Unit 1D (UID)
Press OK.

Description: Each device should have a description so that the
user can have a quick reference for the status of the device.
Use only a brief description. This is the description that appears
in the Device Status Monitor.

Enter something that describes the device, such as: X Axis,
Gripper, Shuttle, etc.
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Manual Register Device

Prezs "Add Device' to manually
register a device.

. . Sort by UID
Mote, QuickControl automaticaliy S
registers any attached devices when

"Scan Metwark! is preszed. izelE

ik

Add Device Delete Device| Fave Down |
uib |Desc | Cont-Mator Auto
16 UID=1E C DG AZIH3 1=

unique. Factory default is 16.

Unit ID: Enter the device’s Unit ID (UID). The device’s
Unit ID is entered here. Unit ID for devices must be

Description

Edit device descrption.  Thiz can be anything pou
want [i.e. ¥ Auxis)

Device Description

Gnip Axiz

Cancel

555
_ Coredl |



file://10.10.8.20/quicksilver/QCI_Docs/SilverLode%20Manuals/SilverLode%20Manual%20Rev%206.03%20Release/Register_Device_Dialog_Box.htm
file://10.10.8.20/quicksilver/QCI_Docs/SilverLode%20Manuals/SilverLode%20Manual%20Rev%206.03%20Release/Polling.htm
file://10.10.8.20/quicksilver/QCI_Docs/SilverLode%20Manuals/Overview_and_Menus/External_Device_Status.htm

Press OK. Select Device Type @

Select device from following list.
Select Device Type: Select the Product Line/Driver, I/O Option, —
ANCEl
and motor that matches the controller/motor you are
. . Product Line
registering. _
Drriver oz -
1/0 Option G o
Press OK.
QCI |-Grade 17-1 [A171)] o~

QC -Grade 17E-1 [A17K1)

H i i QC -Grade 17-3 [A173) =
The device will now appear on the list. o e ) =
GC! |-Grade 17H-3 [A17H3)
QC -Grade 23-3 [A233)
QCI |-Grade 235 [A235)
QCI |-Grade 23H-1 [A23H1
QACI |-Grade 23H-3 3
QCI |-Grade 23H-5 [A23H5)
GC! |-Grade 23T-7 [A23T7) -

Manual Register Device

Press "add Device" to manualiy g
reqister a device.
Hote, QuickConirol automaticalk Sort by UID Double clicking in the Auto cell will toggle whether the device is
regiters any aftached devices when . )p Auto registered or not. When Auto registered, all fields except

"Scan Network' iz preszed.

AddDevice | Delste Device| Move Down | for Description are filled automatically by reading the device
UL | Desc | Cont-Matar ALt information.
16 | DZIG A23H3 ves

D26 A23H3 o

You can change the order by pressing Move Up, Move Down or

Sort by UID.

Register Device Options
Prompt On Delete (default checked)
Checking this box will cause QuickControl to prompt you when you do delete operations.

Automatically Scan ID Range
This is the Unit ID range that will be scanned for when the Device Status Monitor, Scan Network button

is pressed. The default is 1-20 which makes the "scan" a reasonable length of time. NOTE: This also sets
the range for the SilverLode Identify (IDT) command.

Disable Automatic Scan
Check this box to skip network scan when Scan Network button is pressed. Only the manually registered

devices will be polled.

Baud Rate
PC baud rate ranges from 9600 to 115K. Default is 57.6K. It is a good idea to leave it here unless you are

familiar with serial communication.

Protocol
Each port needs to know how to communicate with the agﬁpéﬂéﬁ'fglngfﬁfe‘iﬁ::d Prarity.
devices connected to it. The protocol sets up the Comm port < Stop Bits. No Parity
so that it can send and receive data in the proper format. The
protocols listed are the ones currently supported, including Pratocal [Defaul: BBit ASCH)
QuickSilver 8-Bit ASCII, QuickSilver 9-Bit Binary, and |8-Bit A5 ~]
Modbus™. Parity and Stop Bits [Default: 2 Stop Bitz, Mo Parity)
|2 Stop Bits, Mo Parity -
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NOTE: Changes to Baud Rate and Protocol only affect the PC. They do not affect the attached device.
You must use the Initialization Wizard to change the parameters in the device. Therefore, if you want to
start talking to the device at 9600 baud, you will first have to change the baud rate for the device, and
then change the baud rate for the computer.

Stop bits and parity need to be matched between the comm port and the controller. Normally 2 stop
bits and no parity are use.

E-485 Bridge (Ethernet) Comm Properties ==
This tab is for editing the properties of the optional E-485
Bridge. The E-485 Bridge is a module on the controller Cancel
that accepts standard Ethernet and converts or "bridges"
it to the controller's RS-485.

‘COM  E-435 Bridge [Ethemet] ]

E-485 BEridge IP Addresz

E-485 Bridge IP Address Enter address in form of 101013210
Press Browse to have QuickControl browse the local e ko Browse network Browse
subnet for devices with E-485 Bridges. See "Set All E-485 Configure E-485 Bridge

Bridges to Defaults" below if Browse does not find an Change [P &dr | Set Baud Rate | SetTo Deraults|
attached device. Alternatively, enter the IP address of N ot Al E-455 Bicgos To Dol |
the E-485 Bridge you want QuickControl to connect to. 8-Bit ASCI Only

Configure E-485 Bridge
Configure the E-485 Bridge with the above IP address. Note, the following functions configure the E-485
Bridge on the attached controller. The bridge will use the new configuration both now and on future
power ups.

e Change Adr (default DHCP): Allows the user to change the E-485 Bridge's IP address or
configure it to use DHCP.

e Set Baud Rate (default 57.6K): Allows the user to change the E-485 Bridge's RS-485 baud rate.
This is the baud rate the E-485 Bridge will use to communicate to both the local servo controller
and any other controllers attached to the RS-485 network. Note, the controller's baud rate (i.e.
BRT command) must match the baud rate set here.

e Set To Default: Press this button to download the factory default configuration to the E-485
Bridge. Note, this only configures the E-485 Bridge and does not alter the controller's memory.

Set All E-485 Bridges to Defaults

Press this button to download the factory default configuration to all E-485 Bridges on the local subnet
(see "Set To Default" above). This is sometimes required before QuickControl can "Browse" a device. For
example, if a device was previously configured for IP address 10.10.10.200 and was then moved to
subnet 10.10.20, "Browse" would not find it.

For additional information on the E-485 Bridge, see Technical Document “QCI-TD056 E-485 Bridge —
Ethernet”.

Phase Alignment
The alighment of the motor and encoder needs to be calibrated to function optimally, so while all I-
Grade motors and encoders are calibrated in the factory, the Phase Alignment is necessary for any
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systems that include a non-I-Grade motor or encoder. Phase Alignment (Commutation) is accomplished
using the position of the encoder with respect to the motor's rotor.

Start-Up Phase Alignment

Every time the servo powers up, the initialization program calculates a Start-Up Phase Alignment by
moving the motor back and forth a little. It can then go closed loop and begin to servo. This works well

in many applications as long as the motor is allowed to move. If your application has conditions that may
stop the motor from freely moving at startup, or needs more tightly controlled torque, additional Phase
Alignment is suggested. Some such cases include having a motor brake, a vertical load, if the motor is
jammed or if high inertias or higher power motors are involved.

If the motor does not move sufficiently during the Startup Phase Align, it will calculate an incorrect
phase alignment. This will cause the motor to have poor performance. It might not even be able to
move, or it may move erratically. To allow Phase Alighnment for these startup conditions, the alignment
of the encoder with respect to the rotor must be determined a different way.

Index Phase Alignment

Index Phase Alignment uses the encoder's index pulse (z-channel) position to calculate phase alignment.
For this to work, the index position with respect to the motor's rotor is determined by moving the motor
with no load. The alignment is saved to non-volatile memory in the controller. Changing either the
motor or controller requires realignment.

If an I-Grade motor and a SilverDust or SilverSterling I-Grade controller are used together, the motor’s
memory holds the alignment information and is automatically used at power up. The calibration is
performed at the factory. The internal alignment will be used whether or not the Index Phase Alignment
option is selected. This allows motors of the same type to be swapped without rerunning the alignment.

Regardless of controller, if Index Phase Alignment is used, the servo will only use the Startup Phase
Alignment until is sees the index signal at which time it will read the phase alighment information from
non-volatile memory. The I-grade motors use a special z-channel with 49 pulses on a 50 pulse spacing,
making the motion needed to find a z-channel marker much shorter.

Cyclic Phase Alignment

This is a modified Startup Phase Alignment that repeats the start-up move over and over again (cyclic)
until a valid Phase Alignment is determined. This is a good option for applications that do not support
Automatic Index Phase Alignment, but still need improved Phase Alignment while maintaining the ability
to swap motors without re-running the Initialization Wizard.

To use Cyclic Phase Alignment, from Initialization Wizard; open the file Factory Default Initialization -
Cyclic.qcp instead of Factory Default Initialization.qcp. Make sure Index Phase Alignment is unchecked
under Options.

79



Appendix Il Configuring Your PC

Auto Power-Down Options
Many recent drivers include a “Power Management” option which allows the PC to power down the
selected device when the computer (thinks it) is idle. These devices include the USB hubs and the USB
serial ports. Unfortunately, if the keyboard is not in use, the serial port can be powered down even
while QuickControl is still using it, causing a fault. To prevent this, it is necessary to uncheck the “Allow
the computer to turn off the device to save power” option under the Power Management tab for both
the USB serial port you are using, and for the USB hub which services it. If you are not sure, disable the

power save (uncheck the box) for all of your USB hubs.

.

=

USB Root Hub Properties
General | Power | Advanced | Driver | Details | Power Management
USE Root Hub
Allow the computer to tum off this device to save power,
0K || Cancel
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Go to the Device Manager, select each device,
right click and select properties and the
properties box will appear. Select the Power
Management tab, and unclick the save power
box.

The Device manager may be found by opening
up Windows Explorer, selecting the computer
name and right clicking properties. Next select
the Device Manager tab.



Appendix IV QuickControl® Overview

SilverLode products have an extensive command set that allow them to be programmed for a wide
variety of complex applications. SilverLode products need to be pre-programmed if they are to be used
in a standalone or hybrid configuration.

SilverLode products are programmed from a series of commands issued through a serial
communications link. The most practical way to program a SilverLode product is to issue these
commands from the QuickControl software running on a PC. QuickControl is QCl’'s Windows-based
software interface for the SilverLode products. QuickControl can run on an XP, Vista or Windows 7 based
PC connected to a SilverLode product using one of the PC’s serial ports. QuickControl is designed to
make programming SilverLode products easy and efficient. It is also the only programming interface fully
supported by QCl and is required to change the factory default initialization program.

QuickControl® Interface

The main QuickControl screen offers the user an easy to use programming interface with the ability to
monitor the communications status of up to 6 active units connected to the PC Host. An active status log
is available for viewing the status information the active device is sending to the host. In addition, any
device connected to the host can be selected in order to view current position and the active 1/0 states.

The Main QuickControl Screen is divided into five major sections (see figure below).

1) The Menu Bar contains pull down menus with all the functions of QuickControl.
2) The Icon Bar contains the most often-used menu items as shortcuts.
3) The Program Info Toolbar displays programming and program information.
4) The Program Window displays the active program.
5) The Status Log displays messages.
6) The Device Status Monitor provides information about all connected devices.
1 2 6

\ S /5

22 QuickCN\ntrol - [QCIMotkonProg3] ===l
File Edit \iew Progr Tools fip  Window Help

D| || &l 3] % s/ 2| @ A
Program Info Toolbar Z‘ Linet# Label | Command / Device Status Moniter

= I ‘IDE;M / Active Device

rogran Line :

10=15 colnks

| Add [Crit-4) Edit [CrthE] Q

Inset [CrtH) | Delete (CritD) 170 i

W | 5 |50 |5 |8 |5 |5

Programs 1DD+| I I I—I I I I—

Daownload | Download/Restart

e e e o o

Scaling D owrload/Bun Scan Metwark Mat Polling
Test Line | Run wfo Download | ID:Desc/Cont Foz/State
G:UID=16 o data
Deb r
il D24GAZ3HI | Mot Pl
Prograrn Lizt
|F'rogram Mame [0] ﬂ
0 of 1023 words used |
Device To Program
PW A
093319678 UritlD=016: 1G
09:33:19.680; Unit ID=016:  Motor=0C! |-Grade 17K
09:33:19.683 Scan for Unit 10z 1 through 20 complete. Select Setup-»0ptions to change scan range
09:36: 21,218 Program File "Factory Default Initialization.gep' Downloaded
10:20:04.207: If the Moving or Holding Enor conditions are TRUE in the Kil Motor Conditions [KMC] cc
1100 il 1
For Help, press F1 NUM




Toolbar
The QuickControl Toolbar provides shortcuts to certain functions that may be used repetitively while

using the QuickControl software.
T RLLEUEN
1/: 3 4 5 6/ _‘\\ :\10 11 12 13

1 Create a New Program File 2 Open an Existing Program File . .
3 Close the Active Program File.
(.QCP). (.QCP).
4 Save the Active Program File L .
. 5 Initialization Wizard 6 Control Panel
(.QCP) to PC's Hard Drive.
7 Cut Selected Lines From 7 Copy Selected Lines From Program | 8 Paste Previously Cut or Copied
Program File File Line into Program File

13 Stop all motion/executing

9 Print Active Program 11/12 Ver/Help ]
programs on all devices.

STOP @| The STOP button stops all command execution and programs running in all devices
connected to the PC. It can also be used to verify communications to any device as the
Red LED blinks briefly when issued. (Will not affect units running Modbus® protocol.)

Program Window

N

Oper Label | Command
1T:REM START
Mowve 1234 rews @
> MEY acc=39 rps/z
: vel=33 rpz
Stop when /0 #1'" iz Falling
i Jurnp to label START when /0
3:REM H2 = low state
4001 Jump O Input to "START"
: Wihen ULA0 #2" i LOWFALSE

This area of the QuickControl Screen displays the active program opened. It is where all program lines
are created, viewed, and edited. The interface allows the user to single click on the line to highlight that
particular line or double click on the line to edit the contents (parameters) of that line.
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There are three columns in the Program Window.

1) Line Number and Operation — Displays the program line number and the Three Letter Acronym
(TLA) of the command.

2) Label — Allows the user to put in labels for branching operations in programs.

3) Command — Provides a brief summary of the command on that line and the parameters that are
set in that specific operation of the command.

In this example of the Program Window, there are two colors used to differentiate the lines of the
program. Blue is used for actual commands and green is used for the remarks (REM).

Remarks are not downloaded with the commands and are only used for documenting a QCP. When a
label is placed on a REM line, the label is effectively moved to the next command line. If the label is
placed on a REM line that is at the end of a program it will be the next available command line up from
that REM line. In the example above, “START” is a label on line 1, a REM line. The program branches to
the START label from Line 4 when the 1/0 condition is met. Since line 1 is a REM line, when this program
is downloaded to the device the START label will actually point to line 2, the next command line after the
REM line.

Control Panel

The Control Panel is a Tool in QuickControl that provides access to several important features, such as
jogging the motor, toggling inputs/output functions, tuning and testing, as shown below. Additionally, a
strip chart can be displayed to show various motion parameters and is useful while tuning.

[

Control Panel

Tuning Jog Vellcps) Exit
Device ID=16:UID=15 | 430000
Twpe|  AZ3H3 [Rev56-11) 1 EEFP;LE’\?E[ 0| Bestart
Senal # 4549 Move Type ZEm
& WA O MRT  Cycle ]
May T MRY — STOP
—i
Test Move 1 | - | ke B
g atar Drrver
Device Status Pasition [g000 — ] & Enabled
Target Pos|0 caunts Ramp Time |30 mSec ™ Disabled

rostien|0 ounts Total Time: |1000 M ec Inputs/Outputs
Velocit]0 g2 Test Move 2 | Set  Shitt L-Click
Pos Emar|0 counts = — Clear. . Cntl L-Click
—— ; Paszition [ AT  TriState: L-Click
[ Max Error |49 counts grg=lhlgh I
i red=low
anquel?ﬂi Ramp Time 100 mSec o I?I?I?I?I?I:I?I?
= - +
Driver[18.0 volks Tatal Time 1000 mSec J5e [ [ o o

Temp|330 °C Strip Chart | Analog 1 W EIﬁ 3 Iﬁ 4 lﬁ
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Device Status
As long as Polling is running, these fields display the device’s status in Real-Time. The fields include:

e Target Position: The position the servo is being commanded to.

Position: The actual position of the servo.

Velocity: The servo velocity.

Position Error: The difference between Target Position and Actual Position.

Max Error: The maximum error that occurred since last time the Zero button was pressed.
Torque: The servo's torque in percentage of full torque.

Driver: The driver voltage (which may be independent of the processor voltage on some units)
Temp: The measured processor temperature.

Tuning

This section, in conjunction with the Initialization Wizard’s Tuning Wizard, provides the tools required
for tuning the servo loop (see Technical Document QCI-TD054 Servo Tuning for details). Ideally, the
servo would be attached to the axis needing tuning with the real world load. Two moves are provided to
allow the developer to move between two positions (ie. Extend to pickup a widget then retract back to
home). Using an iterative process, the developer would do a move, examine the results on the Strip
Chart, adjust the tuning parameters and start again.

Cycle

Press this button to cycle between Move 1 and Move 2. This is just like pressing the Move 1 and Move 2
Test buttons. If multiple cycles are desired, enter the desired number into the #Cycles field. A "0” in this
field will make the axis cycle forever. Press the Stop button at anytime to interrupt a cycle. Enter a non-
zero value in the “ms delay” field, if some settling time is required between moves.

Moves
The four basic move types are available:

e MAT: Move Absolute, Time Based: Move to an absolute location in a specific time.

e MAV: Move Absolute, Velocity Based: Move to an absolute location at a specific velocity.

e MRT: Move Relative, Time Based: Move: Move some distance relative to your current position in
a specific time.

e MRV: Move Relative, Velocity Based Move some distance relative to your current position at a
specific velocity.

e (Cycle: Select to enable Cycle (see above).

See the Command Reference Manual or Chapter 2 of this manual, Basic Motion Commands for more
details on these commands

Once your Move Type is selected, enter the move parameters and press one of the Test buttons or Cycle
to execute the move.

Jog Slider

The motor velocity can be set in real time by sliding the pointer with the mouse. The Jog Vel field is used
to set the full scale velocities at each end of the slider. Using the mouse, run “Jog Vel” slider up and
down to jog the servo.

84



NOTE: If the Shift key is pressed when the mouse is released, the servo will continue at the same
velocity (it will not stop). This is useful if you want to test constant velocity application.

Zero
Press this button to zero the motor target and position. It also zeros out the Max Error latched value.

Motor Driver
This radio button allows the motor driver to be enabled or disabled.

Inputs/Outputs

This displays the states of all 7 1/0 Channels. A “Red” I/O Channel indicator denotes a logic low and a
“Green” indicator denotes a logic high. If the SilverDust IGB is connected, the additional 16 I/O are also
shown.

Please See Chapter 4: Input Output Functions for more information.

Device Status Monitor [ Device Status Monitor
The Device Status Monitor occupies the right hand portion of the Active Device

main QuickControl window. It provides status information on ID=1E 0 counts

QuickControl and the attached devices. 0 ﬁlilililiﬁﬁ
Active Device (00 Iililililililili

The status of the active device (selected by pressing any cell in the [ o o [ [ [ [0 [

Device Status List) is displayed anytime polling is running. This

|F'u:n||ing

includes the current position of device and the 1/0 Status. If the

ID:Desc/Cont Poz/State
device ID button is pressed (i.e. ID=16), the Register Watch tool will 0 countz
come up. D215 AZ3H3 Frog Stop

|
Device Status List

This portion of the display is used as a quick reference to the Registered Devices. QuickControl uses a
polling routine to check the status of these devices. Each device has four (4) cells which contain the
following data:

Unit ID
Description Actual Position

\ |/

16:UID=16 -2 counts
D2-|GE &23H1 F'rn:|5| Stop

/ \ Device State

Motor

Controller
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Device State
The device can have the following states:

v
v
v

Not Pol: Not polling (press Scan Network to start polling)

Prog Stop: Polling active. No program running in device.

Prog Stop-Kill: Polling active. No program running in device. Device had an error and is in a Kill
Motor state (shutdown). See Technical Document “QCI-TD052 Shutdown and Recovery” for
more details.

Prog Stop-Soft Limit: Polling active. No program running in device. Device is limiting motion in
response to the parameters set in an SSL or VLL command (see Command Reference for more
details).

Prog Run: Polling active: Program running in device.

Prog Run-Kill: Polling active: Program running in device. Device had an error and is in a Kill
Motor state (shutdown). See Technical Document “QCI-TD052 Shutdown and Recovery” for
more details.

Prog Run-Soft Limit: Polling active: Program running in device. Device is limiting motion in
response to the parameters set in an SSL or VLL command (see Command Reference for more
details).

Edit Details
Normally the detailed string used to send the command is hidden from the user. The Edit Details option
displays a detailed edit dialog box for the selected command, showing the full string. The following two
dialog boxes edit the same command. Edit MAT:Move Absolute, Time Based ==
Edit Event from Events Database "QCIMotionProgd”
- Cancel
Ewvent Mame Event Template Pasition 4
|PDDDLDDDS MAT Move Absolute, Time Based AT Move Abzalute, Time Based Cancel i revs — |_ Description
Data Template STOP LS Stop Condition
TestEwvel Ramp Time
Test
i 100 5 =
Unitio g [~ Timefms) |20 - Description | mSes —
Stop
Example Tx Data |@1B1?80833 833300 T B
otal Time
Ewvent Lines
1000 msec  © li
Lite 1| Data Label Data Type) Data Max Min Scale| Data Orde
0| Command Mumbe  Unsigned 176 176 176 1 Mo Order
1| Position Signed Lc 07418111 74181 1 H-MH-ML
2| Ramp Time Unsigned 833 BB 0 1 H-MH-ML
3| Total Time Unsigned 8333 7483647 2 1 H-MH-ML
4|5Stop Enable - Con Hex*orc Combo  OxFFFF  0w0000 1 Combine t
5| Stop Enable- High Binary 00000000 0000a00 0000000 1 Mo Order
E|Stop Enable - Low Binary 00000000 0000000 0a0o0o0o0 1 Mo Order
7|Stop State - Comt Hexorc Combo  OxFFFF 0w0000 1 Combine
8| Stop State - High  Binary 00000000 0000000 0000000 1 Mo Order
9| Stop State - Low | Binary 00000000 Q000000 0a00o00 il Mo Order

Register Watch | Register Watch o) @ =
The Register Watch Tool is a powerful tool within QuickControl for Add Regiter | MoveUp | UnitID-016 LID-16
monitoring and adjusting the contents of registers. This tool allows Delets Register| Move Down |
QuickControl to simulate a host, allowing an application developer to REGETEL L Uifls
LO:Motor Temp Max | Motor Ten| 0
adjust register values while a program is running within the servo. ge:av Ewn:erg g
elay Lounter|
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Open the Register Watch window from:

Tools->Register Watch

NOTE: Register Watch can also be launched by:

e Press the Device button on the Device
Status Monitor

e Right Click on the device in the Device
Status List.

e Double click on the device’s 2™ row in the
Device Status List.

Select Register

Register

T arget Position (0]
Actual Pozition (1]
Last Index Position [2]
15% | Reserved [3)
Last Trig Position [4)
Delay Counter [5)

YWelocity 1 | Welocity 2 [7]
Reserved [8)

Feszerved | Torque [3)
Acourmulator [10]

Uszer[11]

Uzer ar Input Source Data [12)
Uszer or Input Offset [13)

Uszer or Input Dead Band [14)
Uszer or Masimum S calelLimit [15)

tax Position Emar | Current Position Errar (8]

(S
Cancel

Display

' Register

" Upper ward
" Lower word

[~ Strip Chart
[ Logta File

Sart
r Alphabetically

Press Add Register to add a register to the list of “watches”. The Select Register dialog box allows you to
select watching the whole register or only the upper or lower half.

Check Strip Chart to add a real-time strip chart and/or check
Log to File to begin logging the data to a log file (log files found

in Logs folder).

Select Data Format

dizplay the data in.

Drata Format

After selecting the channel, QuickControl will allow you to & oma

select the data format which enables you to watch the data in £ Ulong
" Hex

your engineering units.

Select the forma.tyou wish to

" Position

(™ Acceleration

(" Target Velocity [326i)  © Torque
" Actual Velocity (16 B Time

Register Watch will watch the registers of the active device as selected in the Device Status Monitor. In

Register Watch you are able to:

v' Change the register being watched by double clicking in the register cell.

v' Change the data by clicking in the data cell and entering new data. Note, although the data will
be changed in the indicated register, it may get overwritten if the program is also modifying the
same register. If the register selectable is not writable, the value will not stay changed on the
display (and will not be changed in the attached unit), and a message will appear in the Status

Log portion of the screen.
v' Change the data format by double clicking

on the units.

Right click on the register (row) to display a pop-up menu with many of edit features including:

v" Column Width: Manually set width of each column

v High Priority: When selected for a given register watch, QuickControl disables all other
background communication including all other register watches and only polls the selected
register. This allows for very fast updates on one register.

NOTE: The more registers you add to the list, the less frequent any single register will be updated.
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Rengter Names Edit Register Names @
QuickControl allows for editing the names of registers &
oK
11 through 199 (user registers). Any user registers
Cancel
used in a QCP file can be re-named to add more
meaning to the program code. For example, registers 0 P
. . . . User ar Input Saource Data [12)
being used for a specific function, like a loop counter User or Irput Dffset [13) =
. X Uszer or Input Dead Band [14) Input Mode Reagisters [12-18)
can be named as SUCh, JUSt like the Input Mode User or Maximum ScalelLimit [15)
. : . Uszer or Magimum Output Scale [16] Set Names SetTo
registers and the Profile Move registers. If the QCP User ar Qutput Offsst [17) To'Lsg | Descriptive
. . Usger or Dutput B ate of Change [18] Mames
file does not use Profile Move or Input Mode User19)
User or Profile Maove Pos (20) ] )
functionality, these registers can be re-named. Lser or Profle Move Acc (2] Prafile Move Registers (20-24]
zer or Profile Move Vel [22)
Uszer or Profile Move Dec [23) Set Mames SEt.Tc.'
User or Profile Move Offset [24) To "User" Desciiptive
Uzer (28] Mames
User 2]
Usger [27)
Access the Register Names dlalog window from the Hz:: {Sg% Reset Select%d::!elgisterName
to Default
Programs pull down menu or from within the Scaling oo )
dialog window found in the Program Info Toolbar. hee E% | el e e te
Hlane (247

Edit Register Mame

=X
Edit Selected Register Name

Berse] Select a register from the list box on the left and press Edit
Register 12 Name Selected Register Name button to re-name it.
Loop He_&et
ﬂgﬁ:;‘ﬁ; Press Reset Register Name to Default to reset the name back
Default

to factory default.

Input Mode Registers (12-18)

By default, these registers already have descriptive names because they are used in the PIM, VIM and
TIM commands. If these commands are not being used, registers 12-18 can be used as general purpose
user registers.

Press Set Name to User to set registers 12-18 to the name “User”.
Press Set To Descriptive Names to set registers 12-18 back to their factory default names.

Profile Move Registers (20-24)

By default, these registers already have descriptive names because they are used in Profile Move
commands (i.e. PMV and PMC). If these commands are not being used, registers 20-24 can be used as
general purpose user registers.

Press Set Name to User to set registers 20-24 to the name “User”.

Press Set To Descriptive Names to set registers 20-24 back to their factory default names.
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Data Monitor

The Data Monitor is a diagnostic tool that
enables the user to view all transmitted
and received data from all enabled ports
as well as send custom packets out any
single active Communication Port. The
Data Monitor can be thought of as a
serial or network analyzer specially
designed for the QCI products. It
provides the tools necessary to test your
master controller’s functionality. The
fields are defined as follows:

Data Monitor

[E=RECR =

R 57Em: =# 10 000C 0000 0000
T B90ms =216 21

4 T

Custom Tranzmit

Enter data in same format as selected in
Dizplay Format or copy a previous
tranzmission by Double Clicking on

Diizplay Format Claze
" Hex " Decimal &+ ASCI

[ LogTaoFie"DMLogtat"
r Only .

o nmpeProtocol = Receive/Transmit (Fx/Tx) Data [~ Qmea[ Discloy

R 480mz =t 10 000C 0000 0000 -

T 434ms =16

R 512ms =% 10

T 526ms =216 1 BE535

R 544ms == 10

2

Trarsmit

transmission.

Add CR

Diagnostics for Device "UID=16" 016 =] @ (=]
Statuz Words ztates in real-time. T Brmashr
State/Kill Mator Cols: "n/a" = not applicable.

Kill Motar Cal: "Kill" = Device killed itzelf due to this condition. Kill Matar I_
Haw |isz |isz |54 o5 | wo |
Wiord | Bit# | Description State Kill Motar
|Sh 0 Index Found FALSE(D)

|5 1 Last Calc Waz Zero TRUE[1] 3
|54 2 Lasgt Calc "Waz Pozitive FaLSE[D)

|5 3 Laszt Calc was Negative FALSE[D)

|5h 4 1/0 #1 HIGH[1]

|5h 5140 #2 HIGH[1]

|5h B 1/0 #3 HIGH[1]

|5 7 Temp/Driver Enablz Ok[1]

|5 8 toving Error FALSE[D)

|5 3 Holding Error FALSE[D)

|5 10 Halt Command Wasz Sent FALSE[D)

|54 11 Input Found On Last Move FaLSE[D)

|5 12 Delay Counter Exhausted FALSE[D)

1S 13 Ower Voltage FALSE[D)

|5h 14 Low Woltage FALSE(D)

|5 15 Reserved FALSE[D)

152 0 Count Down Timer Inactive(0]

152 1 totion Limit Ok[0]

152 2 Encoder Re-phazed ko)

152 3 Fac Blk Driver Enabled(0)

152 4 totor Temp L]

152 5 Driver Temp-Analog L] i
o 1 [3

Firmware Download Wizard

Diagnostics

The Diagnostics dialog box displays the real-
time state of the current QuickControl
program and the system it is controlling.
Further information on all the commonly
used status words can be found in chapter 3.

For those status words that are part of the
KMX or KMC command, the Kill motor
column will display “Kill” if the corresponding
bit was the cause of the Kill Motor. The Kill
Motor “LED” (top right of dialog box) will be
red if a Kill Motor is in effect and green
otherwise.

From time to time QCIl adds new features to their products, which requires a new version of firmware to

be downloaded. The latest firmware and instructions for downloading can be obtained from QCI Product

Support. Please make sure to shut down other background programs that do file saves when

downloading firmware. A failed firmware download will render the device repairable by the factory only.
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Appendix V: Shortcut Key

QuickControl Menu Bar

The QuickControl Menu Bar provides access to all functions of the software. These “pull down” type
menus offer many selections that can bring up other menus to accomplish certain objectives. Above the
Menu Bar, next to the QCl logo & QuickControl name is the active filename being displayed in the
QuickControl Program Window. See Menu Details below for more information.

2% QuickControl - [QCIMotionProgd]

File Menu File Edit View Programs Tools Setup Window Help

o New Program File - Opens blank program template

New Sequence File — Advanced Feature (see Technical Document QCI-TD025: Events and
Sequences).

Open — Opens a saved file

Close — Closes the active file in QuickControl

Save — Saves the current file

Save As — Saves the current file with user set parameters

Program File Properties — Contains scaling, password protection, and user defined names. This
dialog box can also be accessed by pressing Scaling on the Program Info Toolbar. See File Menu
Details below for more information.

o Upload Program File — Retrieves the current program residing in non-volatile memory. See File
Menu Details below for more information.

Print — Prints the active QuickControl Program file to the default printer

Print Setup — Allows the user to change printer and paper settings

All Halt — Sends the All Halt command

Recent Files — Displays a list of files recently open in QuickControl

Exit — Closes the current files opened and exits QuickControl

Edit Menu

e Cut— Removes highlighted section of text or program line

e Copy— Copies highlighted section of text or program line

e Paste — Inserts a copied or cut section of text or program line before selected line

e Select All - Highlights an entire program

e Events — Advanced Feature (see Technical Document QCI-TD025: Events and Sequences).
e Find - Find (search for) text in program file.

View Menu

e Toolbar — When checked, Toolbar will be displayed

e Status Bar — When checked, Status Bar will be displayed

e Device Status — When checked, Device Status will be displayed
e Column Width — Set the program's column widths
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Program Menu

e Add Line — Adds a new line to a program

e Insert Line — Inserts a line above the selected line in a program

e Edit Line — Edits the selected program line

e Edit Line Details - Edits the selected program line with all the command details.

o Delete Line — Deletes the selected line in a program

e Disable Line — Disable selected line in a program. The program line is "grayed out" and is not
downloaded.

e Enable Line — Enabled a disabled line.

New Program — Creates a new blank program

Delete Program — Deletes selected program

Program Details — Allows a user to name, describe, and modify the stored location of a program.

Scaling — Allows a user to adjust scaling parameters and max/min ranges

Register Files — Links register files or file arrays (.txt based) to active QuickControl program (see

Register Files for more details).

e Register Names — Assigns user defined names to registers. See Programs Menu Details below
for more information.

e |/0 Names — Assigns user defined names to I/0 lines. See I/O Names below for detail. See

Programs Menu Details below for more information.

Download — Download program file to device.

Download/Restart - Download program file to device then restart device.

Download/Run - Download program file to device then run first program without restarting.

Run w/o Download - Download program to RAM then run.

Download and Chart - Download program file to device then bring up chart. See Download and

Chart below for more information. See Programs Menu Details below for more information.

Erase Application in Device — Erases current program in non-volatile memory

Toggle Breakpoints — Toggles Breakpoint at current line

Clear all Breakpoints — Clears all Breakpoints in all programs

Single Step - Single step program line. See Program Debugging for details.

Real-Time Trace - Trace Program in Real-Time. See Program Debugging for details.

Jump To Line — Jump program execution to selected line.

Tools Menu

e Initialization Wizard — Sets up and initializes devices. See Tools Menu Details below for more
information.

e Unknown Device Wizard — Establishes communications with a device of unknown parameters.
See Tools Menu Details below for more information.

e Control Panel — Tool for Jogging, Tuning, and Monitoring SilverLode products. See Tools Menu
Details below for more information.

e Register Watch — Change and/or view data in the SilverLode products data registers with this
utility. See Tools Menu Details below for more information.

e Data Monitor — Monitor all data sent and received by a device and the PC. See Tools Menu
Details below for more information.

e Diagnostics - Displays the real-time states of all the commonly used status words.

e Firmware Download Wizard — Downloads firmware to device. See Tools Menu Details below for
more information.
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Setup Menu

Comm Port — Selects Baud Rate, Communications port, and Protocol for QuickControl. See
Setup Menu Details below for more information.

Register Devices — Allows user to manually register devices into QuickControl. See Setup Menu
Details below. See Setup Menu Details below for more information.

Options — Allows user to edit other setup specifications. See Setup Menu Details below for more
information.

Polling — When checked, starts QuickControl polling the network for any connected devices and
then displays the state of the device in the Device Status window

Window Menu

New Window — Creates a new program window

Cascade — Cascades current program windows

Tile — Displays current program windows in a tile arrangement

Arrange lcons — Arranges and aligns minimized program icons

Current Program List — A list of programs currently open in QuickControl

Help Menu

Help Topics — Opens help menu for tutorials and information on QuickControl
About QuickControl — Displays date and version of QuickControl and product support
information

Program Line Right Click Pop-Up Menu
Right clicking on the a program line will bring up a menu with the following items:

Add: Add a new program line below this line.

Insert: Insert a new program line above this line.

Edit: Edit this program line.

Edit Details: Edits the selected program line with all the command details.

Delete: Delete this line.

Disable: Disable this line in a program. The program line is "grayed out" and is not downloaded.
Enable: Enabled a disabled line.

Expand/Collapse: Expand or Collapse this Combo Command.

Test: Executes this line. For example, if the line was a move command, the attached servo
would move.

Column Width: Set the column widths.

Toggle Breakpoint: Add/Delete Breakpoint for this line.

Jump To Line: Jump program execution to selected line.

Copy: Copy this line.

Cut: Cut this line.

Paste: Paste a previously copied or cut line.
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Program Info Toolbar

The Program Info Toolbar is located on the left side of the main QuickControl Screen. This toolbar allows
the user to create, edit, download, and debug programs. It also offers information about programs and
the current device being programmed.

Program Info Toolbar ]
Program Line

Pragram Line _ e Add (Ctrl-A) — Adds a line below selected line
Add [E””"E‘]—l Edit [Cntl£] | e Edit (Ctrl-E) — Edits the selected line
Inzert [CntH] | Drelete [Critl-D) | e Insert (Ctrl-1) — Inserts a line above selected line
Frograms e Delete (Ctrl-D) — Deletes the selected line

Davrload | Davnload/Festart |

Scaling | Download/Fun | Programs
Test Line | Fiun w/o Download | e Download — Downloads all programs in the active file to the
Debug » device.
Program List e Download/Restart — Downloads all programs in the active file to
|F'[|:|g[am Mame [0] j the device and commands the device to restart.

| e Download/Run — Downloads all programs in the active file to

0 of 1023 wordz uzed
the device and commands the device to load and run program 0

Device To Program e Run w/o Download — Runs first program in active file (program
Restart | 0) but does not download anything to non-volatile memory.
Desc "ID=16" 016 | e Scaling — Shortcut to Program File Properties.

| e Test Line — Executes selected line.
e Debug— Opens Debug Toolbar (see Program Debugging later in
this manual for details).

Type AZIHI

Program List
The list of selectable programs currently open in the active QuickControl file (QCP)

No. of words used window
Shows how many words are being used in the currently displayed program

Device to Program
e Restart — Restarts the currently selected device
e Desc— Allows user to select the device being programmed and displays the registered label and
ID number
e Type — Displays type of device currently being programmed
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i QuickControl Utilities
@95 This exercise demonstrates two of the most widely used utilities within QuickControl in an effort to
show their usefulness in prototyping as well as troubleshooting. Upon completion of this exercise,
an understanding of how QuickControl interfaces with the device should be developed.
<CR> is used to represent the carriage return in these exercises. Since the carriage return does not have
a viewable character it is displayed as a vertical bar “|” when ASCII strings are viewed in QuickControl.

1. Initialize the device and press the Start Polling button to ensure functioning communication.

2. Click on Data Monitor in the Tools pull down menu and view the polling routine that QuickControl uses to
report all information about the device. Note that the device never initiates outward communication.
Therefore, every piece of information displayed in QuickControl has to be polled out of the device by this
routine.

3. Check the Data Only box. With this box checked, the Data Monitor only displays the command strings that
QuickControl sends to the device and the device response to those commands. With this box unchecked, each
data string is preceded by TX/RX indicator (TX for QuickControl transmissions and RX for the device responses)
and a recycling clock time. The purpose of the clock is to tell how much time has passed in between a
QuickControl TX and the device RX.

* The TX and RX are redundant because any transmission to the device is indicated with an @ symbol
followed by the ID of the unit (e.g. @16).

* the device responses are preceded with either a “*”,” #”, or “1” character (See Technical Document QCl-
TDO053 Serial Communications on our website for a discussion on the individual meanings of each).

4. Check the Silent box to stop the polling routine from streaming in the Data Monitor and scroll up in the
window to view the routine in detail; or, check the Log to File box and press the Log to File button to select a
specific location and text file to log this routine to.

5. Note the commands used in the basic polling routine (details may be looked up by command number in the
Command Reference if desired) and the data registers that are queried.

* @16 12 1<CR>: This Read Register (RRG) command queries the Actual Position[1] register.
*  Actual Position is displayed in the Device Status Monitor and is updated due to this line of the polling
routine.

6. Click on Register Watch in the Tools menu and Add Register when the Register Watch utility appears. Choose
Accumulator[10] (or a register that is not being polled by the basic polling routine) and select long format to
view values as signed decimal numbers.

*  Uncheck the Silent box in the Data Monitor and note that Accumulator[10] is now being queried by the
polling routine.

7. Type a “50” into the data box of the added register and press enter. Quickly check the Silent box and scroll up
in the Data Monitor log to view the transmission.

* @16 11 10 50<CR>: This Write Register command writes a 50 into the Accumulator[10] register.
*  This string was issued by QuickControl as soon as data was typed into Register Watch and Enter was
pressed.

8. Move to the Custom Transmit section of the Data Monitor. Type “@16 11 10 100 ” in place of “Test Packet.”
Add the final carriage return character with the Add CR button, and press Transmit.

* Notice that Register Watch is immediately updated by the polling routine.
*  Note how the Data Monitor and Register Watch tools can be used to emulate a PLC, HMI, or other host
that sends data serially to the device.
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Appendix VI Techniques for Stopping Motion

When using dynamic systems to control complex motion, provisions for stopping movement and exiting
those operations must be addressed. The servo has the functionality to accomplish this through either
software or through hardware (not available on all models) via the Drive Enable option.

Software Stop Options

The commands described below are the software stop options available to stop the servo's motion. All
of these options are part of the Command Set and can be used as interrupts to stop motion as described
below. Some commands initiate immediate stops while others allow for a predetermined deceleration
profile. Immediate stops use maximum acceleration available (and consequentially maximum current
available) to stop the servo as quickly as possible; immediate stop options may re-generate a significant
amount of power back into the power rail that could damage the driver circuitry or motor windings of
the servo. Technical Document QCI-TD0006 contains more information regarding QCl voltage clamp
modules that safely dissipate the re-generated power. (Note SilverDust IG and IGB have onboard clamp
circuits; only use with load resistor attached!) When designing a stop for the motion, consider the
move velocity, load inertia, available back EMF protection, and importance of the stop condition.

The Stop (STP) command not only stops the present motion, but also exits the current program and puts
the servo into a holding state once stopped. The STP command can be formatted to use a specific
deceleration, use the current move’s acceleration parameter to decelerate to a stop, or use maximum
deceleration to achieve an immediate stop where the target position is set to the present position.

@| The red stop hand button in the QuickControl Icon Bar is issues an all stop command. It sends
the Stop (STP) command to ID 255 and all the servos connected to the PC will stop.

The Halt (HLT) command stops the execution of any command, program, and motion in progress. It also
disables the servo drive, which allows the shaft to spin freely and starts the Kill Motor Recovery routine
where the recovery method can be programmed (see Technical Document QCI-TD052 Shutdown And
Recovery on our website).

The Hard Stop Move (HSM) command provides a means to execute a hard stop while multi-tasking. A
hard stop immediately disables the Trajectory Generator stopping any movement and exiting any move
operation (e.g. Step & Direction). This causes an abrupt stop, which in many cases will cause the servo to
overshoot the stop position and oscillate until settled.

More controlled stops can be accomplished by using the Velocity Mode (VMP or VMI) command, which
allows a predetermined deceleration profile to stop the servo. Use this command to specify a
deceleration to zero velocity, stopping the servo.

The Profile Move Exit (PMX) works much like the VMP stop and will be discussed in the Profile Move
section of this chapter. With this syntax it is unnecessary to specify a velocity. PMX uses the deceleration
register for Profiled Moves (Register #23) to slow to a stop.

Soft Stop Limits (SSL) can also be used to stop any type of move. This command defines two data
registers as end of travel limits. Once values are stored in these registers, any motion affecting the
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target is limited to keep the target position more than the first register value and less than the second.
For SilverDust and SilverSterling controllers, the limits are applied to any calculated motion command,
producing normal ramping to limit at the target. Other motions, including camming and velocity moves
do not produce a ramping to stopped at the limit (nor do SilverNugget controllers).Motion that exceeds
a limit (except as already described) is hard stopped at the point that the limit is encountered so no
ramping occurs. A status bit is set (allowing Kill Motor to respond if desired), but the active command
and/or motion are not affected. This allows motions including VIM,TIM,PIM to be limited without exiting
their operation.

Hardware Stop: Drive Enable feature

A hardware driver enable/disable feature is available as an additional option for many SilverLode servos,
but is standard on those servos with separate motor winding power (i.e. SilverLode products designed
for 34 frame motors). It is also standard on the SilverDust IG and IGB. This feature allows the motor
driver circuit to be disabled via a solid-state switch. Disabling the motor driver cuts off torque, while the
DSP control electronics remain active to track position and respond to commands. With the absence of
torque, the load inertia may cause the servo to coast to into a hard stop; deceleration may not be as fast
as with a commanded motion.

Using Inputs to Stop Motion

All basic motion commands, as well as the input mode and velocity mode commands, have integrated
stop conditions. The stop conditions include the digital inputs, as well as several other internal signals
and states, which may be selected within QuickControl. Digital inputs may be wired to sensors, switches,
or digital I/0 from a PLC or other host. Whatever the hardware connected, the servo's I/O can be used
either alone or in conjunction to affect the operation of motion commands.

Standard Stop Conditions - QuickControl

Most moves have a dialog box that looks something like the Edit MAT dialog box pictured here. Even if
the dialog box looks a little different for a particular move command, the Stop conditions can be
accessed by pressing the “Stop Condition ” button.

. . Edit Stop Conditions
Edit MAT:Move Absolute, Time Based @ This brlngs up the s‘and:m | Advances |
-—DK standard “Edit Stop B
Conditions” dialog - -
Position m’ b h h Disble - OW/FALSE
——— ox, which presents a 1072 E
i TEvs — I_ Description . ’ . P i%gé =
simple interface o |
Stop Condition displavi th
Ramp Time Isplaying the
Ton 5  — Lest ; ;
o=t available inputs and
St "
_ s conditions. Co o |

Total Time

1000 mSec Ii
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Standard Stop Conditions - Serial Communications
The same stop conditions presented within QuickControl are available when sending commands from a
host.

Stop Enable
This move parameter is Stop Enable and is the same as the Jump Command Enable Code parameter with
the exception of 0 which means "Do Not Check for Input".

Stop State

The stopped state selected can be either level or edge sensitive. This allows stopping on high states, low
states, on the transition from a high to low or a transition from low to high. Stop states are setup using
the following parameters:

Stop State | Stop on the Following Condition

FALSE

TRUE
FALLING (TRUE to FALSE Transition)
RISING (FALSE to TRUE Transition)

WIN|—L|O

For example, to issue a Velocity Mode, Immediate (VMI) command that will stop when I/O #7 is high,
the following string would be issued.

@16 15 200000 100000000 -7 1<CR>

See Command Reference for details on the VMI command.

Advanced Stop Conditions
For details on Advanced Stop Conditions, see Technical Document QCI-TD039: Move Command Stop
Conditions - Advanced.
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Appendix VII Encoder Outputs

Many of the SilverLode controllers can output their internal encoder signals.. The main reason to use
this feature is for an electronic gearing, or following application (see Application Note “QCI-AN019
Electronic Gearing”). This feature is useful for multi-axis systems that must move in unison (the two
servos would not be truly synchronized, however, because of the unavoidable processing lag between
the lead and following unit, so high-precision systems may need to be coordinated with an external
controller like a PLC). The raw internal encoder output function is just that: a buffered copy of the A and
B quadrature signal that the servo uses for internal control purposes.

Internal Encoder Output (SilverNugget Only)

A SilverNugget servo can output its raw internal encoder signal through specific I/0 lines. This signal is
the same A and B quadrature and index pulse signal that the servo uses for internal control and motor
commutation purposes. The A signal is output on I/O line 1, the B signal on I/0O line 2, and the index
signal on I/O line 3. The command needed to send the raw internal encoder signal to the 1/0 lines:
Enable Encoder Monitor (EEM). The Disable Encoder Monitor (DEM) returns the 1/O back to normal
usage. 1/0 lines 1 to 3 must be configured as inputs before the EEM function is used in order to avoid an
error.

Internal Encoder Output (SilverDust-IGB Only)

The encoder signals are available on 3 dedicated terminal blocks: Encoder outputs A, B, Z. These are TTL
buffered outputs. Note: the Z-channel of I-Grade motors is a special index channel. The output is a 50%
duty cycle spaced at one cycle for 1/50 revolution, with one “tooth” missing. QuickSilver documentation
refers to this as a 49/50 index channel.

Internal Encoder Output (SilverDust-IG8 Only)

The internal encoder signals may be configured to drive either 104, 105, and Optionally |06 with Encoder
outputs A, B, Z using the Encoder Monitor (EMN) command. Alternatively, the SSI port may be
configured to output differential A, B, Z signals from the internal encoder using the SSI command. Note:
the Z-channel of I-Grade motors is a special index channel. The output is a 50% duty cycle spaced at one
cycle for 1/50 revolution, with one “tooth” missing. QuickSilver documentation refers to this as a 49/50
index channel.

Scaled Internal Encoder Output (Modulo Output)(SilverNugget Only)

In addition to the raw encoder signal, the SilverNugget can output a scaled version of its internal
encoder signal with the modulo output function. This function can also be used to output an external
encoder signal if required. A SilverNugget can only scale the modulo output signal down. The modulo
output function is essential for synchronized multi-axis applications since it allows the master to output
its encoder signal for the other servos to follow.

The modulo encoder output function can use all three high speed I/0 function signal formats: step and
direction, step up/step down, and A & B quadrature. The output signal is scaled using the modulo
scaling parameter, which can be set to any integer value between 1 and 256. (1 to 32 for SilverNugget
N3.) The output signal is different for the three signal formats. For the step and direction and step
up/step down signal formats with the scaling parameter set to “1”, the 4000 counts per revolution
internal encoder signal is output as a 2000 pulses per revolution signal. For A & B quadrature format
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and a “1” scaling parameter, 4000 counts per revolution from the internal encoder is output as a 1000
pulses per revolution. If an A & B signal is sent to another servo, the decoding circuitry in the second
servo will turn the 1000 pulses per revolution back into a 4000 counts per revolution signal. A scaling
parameter other than “1” will scale the modulo output signal down by the scaling factor: e.g. foran A &
B quadrature output with a scaling parameter of “4”, 4000 counts from the internal encoder would be
scaled to 250 pulses (which decodes to 1000 counts).

Three commands are used with the modulo internal encoder output function. The Modulo Set (MDS)
command enables the modulo output function and starts the signal from I/O lines 6 and 7, the lines that
the modulo output function uses. The MDS command sets the modulo divisor (1 to 256), the signal type
(step and direction, step up/step down, or A and B quadrature), and the encoder source (internal or
external). The Modulo Trigger (MDT) command enables a special modulo function that uses the state of
I/O #1 as a trigger to start and stop the modulo internal encoder output signal on /O lines 6 and 7. The
Modulo Clear (MDC) command disables the modulo output function and frees the 1/0 lines used by the
modulo output function. More information on these commands is available in the Command Reference.

Synchronous Serial Interface (SilverDust IG8 only)

The SSI port is the 10 pin connector on the top of the SilverDust IG8 Package next to the CAN Switches. It
provides a total of 4 differential interfaces as well as +5v and ground. The I/O are RS485 signal levels
with a 3.3v drive level. These |0 may be variously configured to provide different functions via the SSI

command.
SSI Mode [Description 1 2 3 4 5 6 7 8 9 10
Input External N.C.
0 Encoder* A- (IN)|A+ (IN) [B- (IN) |B+ (IN) [GND [+5v [Z- (IN)|Z+ (IN) |N.C. (IN)]|(IN)
Output Internal|A- A+ B- B+ Z- N.C.
1 Encoder (OUT) [(OUT) |[(OUT) |[(OUT) |GND [+5v |(OUT) |z+ (OUT)|N.C. (IN) |(IN)
SSI position to [Data- [Data+ |Clock- [Clock+ Select- Select+ |Data- |Data+
2 Reg 253 (OUT) [(OUT) |(OUT) |(OUT) |GND [+5v |(OUT) |(OUT) [(IN) (IN)
SSI position to
Reg 253, Dual |Data- |Data+ |[Clock- |Clock+ Select- Select+ |Data- |Data+
3 Loop (OUT) [(OUT) |(OUT) |(OUT) |GND [+5v |(OUT) |(OUT) [(IN) (IN)

* Must also configure SEE command to select External Encoder onto 10 4,5,6
(IN) = 485 differential input, (OUT) = 485 differential output, N.C = No Connect

Mode 0 is the default power up mode. The SSI port is placed with all sections configured as inputs.
Inputs A,B, and Z may be directed to 10 4,5, and 6 by means of the Select External Encoder (SEE)
command. This provides a means to interface an external differential encoder or Step and Direction
source to the Unit. |10 4,5, and 6 may not be used for other purposes if so configured.

Mode 1 configures A,B, and Z as outputs, and outputs the raw internal encoder signals to the SSI port,
allowing for differential signaling of these signals to other units.

Mode 2 configures the SSI port to send and receive serial data. Every 120us the chip select is asserted
and data may be sent and received, clocked by the serial clock signal, running as a burst of 1.5MHz
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pulses. The number of data bits transferred is selected via the SSI command from 8 to 32 bits. (Note: For
data > 16 bits, there may be a slight pause between the first 16 bits transferred and the remaining.).

Data OUT (MOSI by SPI specifications) takes data from CAN object 2009h, sending up to 32 LEFT
JUSTIFIED bits to the SSI port, as clocked by Clock. Data IN (MISO by SPI specs) takes data from the SSI
port and deposits it right justified into register 253. Upper unused data bits are masked to zero. No
wrap-around is provided for absolute encoders operated past their limits.

Mode 3 configures the SSI port the same as does Mode 2, except that the SSI port is flagged as the
source for dual loop data if the DLC command is activated following this selection. The dual loop source
may not be changed if dual loop is active.
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